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Enhancements play a vital role in the evolution of Infinite Campus. With each Release Pack, a number of
enhancements are included as a way of continuously improving existing functionality as well as providing new
functionality to advance the Infinite Campus experience.

This page describes all major enhancements included per Release Pack and serves as a convenient way for
users to view/reference when an enhancement was added.

For information about enhancements in Release Packs prior to .2028, see the following PDFs:

This page covers major functionality modifications and does not describe all cases considered an
enhancement. For a comprehensive list of all modifications made (including bugs and state reporting
modifications), please review release notes for each Release Pack.

Campus.2124
Activity Registration - New Option to Copy an Activity
PATH: Activity Registration > Activity Dashboard; Activity Registration > Activity Monitor

To save time, users (with Add tool rights) can now copy an existing Activity in the Activity Dashboard and the
Activity Monitor. When you copy an Activity, Campus creates a new Activity by duplicating most of the
information from the existing activity. Registration and Activity dates are not copied and must be entered.
Campus verifies Activity Owners, Ad Hoc filters and Custom Forms are still active and requires you to update
that information if necessary.

Product Information: Activity Dashboard, Activity Monitor and Activity Roster

New Form Batch Setup Tool Added
PATH: Student Information > Form Batch Setup

A new tool, Form Batch Setup, has been added that allows teachers to mass assign Custom Forms to students
in a section.

Product Information: Form Batch Setup; Forms; Custom Forms on Portal Process

Campus Release Pack Enhancements .1929 - .2024
Campus Release Pack Enhancements .1829 - .1925
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Draft Special Ed Plans Added to Portal
PATH: Portal > Documents; System Administration > Portal > Preferences > Display Options; Student
Information > Special Ed > General > Documents

Draft Special Ed Plans can now display as read-only on the Campus Parent and Campus Student Portal. From
the Special Ed Documents tool, users can choose when a draft Plan will Publish to the Portal. In order to make
changes to a draft Plan that is already on the Portal, users will need to remove the document from the Portal
first.

Product Information: Campus Parent Portal; Campus Student Portal; Display Options; Special Ed Documents;
Special Ed Document on Portal

Special Ed Caseload Updates
PATH: Student Information > Special Ed > Caseload

Several updates have been made to the Special Ed Caseload, including additional Enrollment validation and
format updates to the CSV report layout.

Product Information: Special Ed Caseload

Student Locator - Student Number Assignment
PATH: Student Information > Student Locator; System Administration > Preferences > Student Number Format

The Student Locator now assigns local student numbers based on the Student Number Format Preference.

When the Student Number Format is set to *No Auto Numbering*, a user can enter a specific student ID number.

When the Student Number Format is set to any of the other options:

When the person already exists in the database and is already assigned a Student Number, modification of
that number is not possible (the field displays in gray text and edits cannot be made).
When the person already exists in the database, but a Student Number is NOT assigned, red text displays
indicating the number is Automatically Generated.

The State ID assignment is managed by the Student State ID Method System Preference and has not been
changed with this update.

Product Information: Student Locator; Student Number Format

Messenger (Email) - Chinese Characters Supported in Email
Messages
PATH: Messenger > Message Builder; Emergency; Staff Messenger; Attendance > Attendance Messenger;
Behavior > Behavior Messenger; Campus Instruction > Class Messenger; POS > POS Messenger

Campus Messenger tools have been updated to support the use of Chinese characters for email messages only.
Chinese characters are not supported in Voice/Text. This update applies to the following messenger tools:
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Attendance Messenger
Behavior Messenger
Class Messenger
Emergency Messenger
Grades Messenger
Message Builder
Missing Assignment Messenger
POS Account Messenger
Scheduling Messenger
School Choice Messenger
Staff Messenger
Survey Messenger
User Account Messenger

Product Information: User Account Messenger; Survey Messenger; Staff Messenger;School Choice
Messenger; Scheduling Messenger; POS Account Messenger; Missing Assignment Messenger; Message
Builder; Grades Messenger; Emergency Messenger; Class Messenger; Behavior Messenger; Attendance
Messenger

OneRoster - IMS Global API for Assessments, Ability to Import
ScoresZ
PATH: System Administration > Learning Interoperability

Assessment results functionality with an API established through IMS Global is now available and Campus has
completed testing with Pearson Ames Web. Using OneRoster technology, vendors can now import assessment
data to state and district installations.

At this time, a manual connection to assessment vendors is required through the Learning Interoperability tool. A
connection needs to be created, then the Assessment toggle can be set to Yes. Districts should verify with their
assessments vendor to determine whether they are able to utilize this API for other assessments.

In future releases, assessment vendors will be added to the list of available Campus Digital Learning partners.

Product Information: Learning Interoperability

Refresh OneRoster Cache
PATH: System Administration > Learning Interoperability

A button called "Refresh OneRoster Cache" has been added to the bottom of the Learning Interoperability/Digital
Learning Application Configuration tool. A process alert is sent when the refresh is complete. A refresh cannot
be triggered if one is already in progress.

Product Information: Learning Interoperability

Online Payments - Deposit Reporter Export
PATH: System Administration > Payments > Deposit Reporter
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Now users can export detailed information from the Deposit Reporter. Report information can be exported as an
Excel, PDF or CSV file. The exported report only includes the columns that are visible on the screen. As part of
this update, information on the Deposit Detail panel can now be exported as a CSV file.

Product Information: Deposit Reporter (Payments)

Online Payments - Option to Run Payments Reporter by Deposit
Dates
PATH:  System Administration > Payments > Payments Reporter

Users can now filter report results according to Deposit Dates. Previously, only Payment Dates could be used. A
new dropdown list called "View By" allows users to select whether they want to use Payment Dates or Deposit
Dates when generating the report.

Product Information: Payments Reporter

Records Transfer - Student enrollmentID Added to Requesting and
Releasing Districts Records Transfer 
PATH: System Administration > Data Utilities > Student Records Transfer

A district’s student enrollmentID is now included in both the requesting (requestEnrollmentID) and release
district’s (releaseEnrollmentID) records when transferring records. This update helps to ensure the proper
enrollment records are matched for each student between districts.

Product Information: Records Transfer; Student Records Transfer; National Records Exchange

Report Preferences
PATH: System Administration > Preferences > Reports (Preferences)

The Publish to Portal label has been changed to Available In, and now allows the selection of Instruction
(previously labeled as Available in Campus Instruction) and Portal.

When Instruction is marked, teachers have the ability to generate Report Cards.
When Portal is marked, reports are available in Campus Parent and Campus Student.

Reports that were marked as Publish in Portal and Available in Campus Instruction were converted to also be
marked for Instruction and Portal.

This change applies to Report Cards, Schedules, Transcripts and eTranscript.

Product Information: Report Setup

Premium Survey Designer Question Types to Use Campus Digital
Repository
PATH: Surveys > Survey Designer
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The following premium Survey Designer question types have been updated to store data only within the Campus
Digital repository (CDR):

File
Signature Pad
Image
Image Picker

NOTE: Premium question types are only available for districts who have purchased the Campus Analytics
Suite.

These question types are not available for Schools/districts who do not use the Campus Digital Repository.

Product Information: Survey Designer

Transcripts Performance Optimization
PATH: Student Information > General > Transcript

Performance has been optimized on the Student Transcript tool to address slow loading of SCED fields and the
Score field.

Product Information: Transcripts

Campus.2120
Activity Registration Updates
PATH: Activity Registration

The following changes were made for Activity Registration.

When a Primary Owner is not the person who created the activity changes the Primary Owner to another
person, Campus now displays a message explaining that they will not have access to the activity after they
save their changes.
When a Primary Owner is not the person who created the activity and changes themselves as the Activity
Owner (Secondary), Campus now displays a message explaining that they will have only have read-only
access to the activity after they save their changes.
The Campus Portal now finds the student's current enrollment record and checks that school's portal
preference to determine whether Activity Registration section should display. If there isn't a current
enrollment record, Campus will use a previous enrollment record to determine if the Activity Registration
section can display.
If a user opens an activity in the Activity Dashboard that is "View" only, the button on bottom is now Close
and not Cancel.
Users can now select multiple people in the Primary Owner field.
A "Created by:" field with the name of the person who submitted the activity for proposal or created the
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activity to was added to Step 1 on the Proposed Activity/Activity Builder.
Approvers can now skip to the final step in the review process and are not required to enter a Category or
Product Type when returning or declining an proposed activity. However, Category and Product Type are
still required to approve a proposed activity.
Users submitting a proposed activity can now skip to the final step in the process when a proposed activity
has been returned.
Users cannot approve their own proposed activity.
The title of the Recall window was changed from "Removal Details" to "Recall Details".
When the "Additional Forms Pending" checkbox is marked, the "Approved" option on the final step is
disabled.
A message was added to the end of the Proposal Workflow to notify users that they cannot approve an
activity because required fields are missing or additional forms are pending.
If a user does not have Delete rights to the Activity Dashboard, they cannot see the Delete option now.
Comments can now be appended (if needed) on declined and returned activity proposals.
The Additional Forms Pending Checkbox selection was not saving when the activity status was "In
Review." This issue was corrected.
Comments were not saving for proposed activities prior to being approved. This issue was corrected.

Product Information: Activity Registration

Transcripts - Course Catalog Display
PATH: Student Information > General > Transcripts

The name of the Course Catalog displays after the name or number of the course in the dropdown list when
adding or modifying a transcript record.

Product Information: Transcripts

Transcripts - Credit Information Fields
PATH: Student Information > General > Transcripts

When adding a new transcript record, a blank row of Credit related fields displays. This allows users to add the
appropriate credit values without having to add a row first.

Product Information: Transcripts

Transcripts - Record Selection
PATH: Student Information > General > Transcripts

The view from the Main screen of the Transcripts no longer displays a tool tip when hovering over that record.

Transcript records sort by Course Number ascending in alphanumeric order starting with 0, 1, 2, 3, A, B, C, then
by Course Name alphanumeric order, then by Actual Term number, numeric ascending (12 is after 2), then by
the transcript ID. For example:

000123 - Algebra
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0001234 - Algebra
000200
02
123 - Algebra
ALG123 - 123Algebra
ALG123 - Algebra

Product Information: Transcripts

Special Ed - Locked Special Ed Documents Added to Portal
PATH: Student Information > Special Ed > General > Documents; Portal > Documents 

All locked Special Ed documents, including IEPs, Evaluations, Progress Reports, and Prior Written Notices (OH
Only), now display as read-only on the Campus Parent Portal and Campus Student Portal.

Product Information: Campus Parent Portal; Campus Student Portal; Display Options; Special Ed Documents

Forms Tool Enhancement
PATH: Student Information > General > Forms  

New functionality has been added to the Forms tool to allow users to select when a Form will be available on the
Campus Parent and Campus Student Portal.

Product Information: Forms

Online Payments - Deposit Dates
PATH: System Administration > Payments > Deposit Reporter

The Deposit Date displaying in Campus did not always match the date in some district's bank accounts.
Changes were made to better align these deposit dates

Product Information: Payments Deposit Reporter

Failed and Excessive Reindex Statuses Added to Search Framework
Status Tool
PATH: System Administration > Search Framework Tool 

The following statuses have been added to the Search Framework Status tool:

A yellow status indicating the search framework is taking longer than expected to reindex.
This message appears if a site is taking more than 4 hours to reindex.

A red status indicating the search framework is taking much longer than expected to reindex.
This message appears if a site is taking more than 24 hours to reindex.

Product Information: Search Framework Status
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Campus.2116
Campus Instruction - Assignment Updates
PATH: Instruction > Grade Book > Add 

The process for adding a new assignment to multiple sections has been streamlined. To add an assignment to
multiple sections, click the Save and Add Sections button after entering the initial assignment details. Select the
desired sections in the list that displays and then modify dates and grading as desired. Dates auto-populate to
match the original assignment. Set grading individually or click the Fill button in the column header to set
grading en masse. Any grading details that can apply to all sections (such as an alignment that is valid in all)
populate by default.

Product Information: Assignments & Resources

Activity Proposals and New Activity Dashboard Tool
PATH: Activity Registration > Activity Dashboard; Activity Monitor

A new tool called "Activity Dashboard" is now available. This tool allows primary and secondary activity owners
to manage their activities. Activity owners can see previous, current, upcoming and proposed activities. The
proposed activities feature is also new with this release. The Activity Dashboard allows users with the
appropriate tool rights to propose new activities.

When an activity is proposed, it appears in the Activity Monitor under the "Proposed" filter. Users with read rights
to the new Activity Registration > Activity Monitor > Activity Approval tool right can view proposed activities and
approve, decline, or return (for changes) the activity to the user who proposed the activity.

Notifications appear for the appropriate users when a proposed activity is submitted and when a proposed
activity has been reviewed. (Notification links for proposed activities are currently unavailable in the new look
and feel of Campus.)

Product Information: Activity Dashboard; Activity Monitor

Campus Learning - Staging Sites for Learning Interoperability
PATH: System Administration > Campus Learning > Learning Interoperability

Staging sites have been updated to populate the correct data in the Learning Interoperability tool (Digital
Learning Application Configuration). This change means that districts can test their OneRoster connections on
staging sites.

Product Information: Learning Interoperability

Student Blended Learning Group Assignments
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PATH: Student Information > General > Blended Learning Group Assignments, Attendance 

The Blended Learning Group Assignments tool, first released in the Campus.2112 Release, now allows for the
editing and adding of blended learning groups.

The Student Attendance tool no longer allows the editing and adding of blended learning groups.

Product Information: Blended Learning Group Assignments, Student Attendance

Learning Tools on Assignments - Accept Scores
PATH: Instruction > Grade Book > Add > Learning Tool

When a teacher attaches a Learning Tool with score passback enabled to an assignment, the Accept Scores
checkbox is now marked by default.

Product Information: Attach Content

Delete Images in School Store
PATH: School Store 

Users can now delete any image in the School Store and have the default picture display instead.

Product Information: School Store

Ability to Delete Shared Surveys Added
PATH: Surveys > Survey Designer

The ability to delete a shared survey (user group surveys) has been added to the Survey Designer tool. Now,
users who have D(elete) tool rights for the Survey Designer tool can delete any surveys within the tool (including
user group surveys).

Product Information: Survey Designer

Food Service Bar Code Added to Employee Self Service
PATH: Employee Self Service > My Food Service

Staff members with a food service account and a PIN can now use a barcode to quickly make food service
purchases. The Food Service Bar Code is located in Employee Self Service > My Food Service and can be
scanned at the point of sale.

Product Information: My Food Service (Employee Self Service)

New Fund Description Field
PATH: System Administration > Payments > Payment Setup > Fund Accounts 
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A new field called "Fund Description" is now available on the Payment Setup > Fund Accounts screen. Campus
automatically uses the Fund ID as the Fund Description, but you can change the Fund Description to suit your
district's needs. The field only allows 120 characters and cannot include trailing spaces. The Fund Description
does not automatically display on the Payments Reporter but you can select the column and have it display.

Product Information: Fund Accounts (Payments Setup)

New Fund Description Field
PATH: Student Information > Special Ed > General > Goal Monitoring

The following Goal Monitoring fields have been added to Ad hoc (Ad Hoc > Filter Designer > Student > Query
Wizard > Learner Planning):

Date
Plan
Goals
Objectives
Type of Data
Data Recorded As
Data Entries
Changes in Intervention
Comments
Adequate Progress

Product Information: Goal Monitoring

Expand All/Collapse All Added to Right Click Menu in Pivot Table
PATH: Ad Hoc Reporting > Data Analysis > Pivot Designer 

The Pivot Designer tool has been updated to provide Expand All/Collapse All options in the menu displayed
when right-clicking a cell within a pivot table.

Product Information: Pivot Designer

Payment Deposit Logic for Multiple Accounts
PATH: System Administration > Payments > Deposit Reporter

Logic was added for disbursing money to districts and schools that have multiple accounts and have migrated to
the new payment platform. These disbursements appear as deposits in the Deposit Reporter tool.

Product Information: Payments Deposit Reporter

PIV Card Authentication Registration Process Added
PATH: System Administration > User Security > User Preferences Management > Login Security Settings 
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PIV Card authentication functionality has been updated to include a more streamlined registration process.
These updates allow PIV Cards to fully work as a means of authenticating and logging into Infinite Campus.

For a complete walkthrough of this process, see the PIV Card Registration Process for Administrators and PIV
Card Registration Process for Staff Members articles in the Campus Community Knowledge Base.

Product Information: PIV Card Registration Process for Administrators; PIV Card Registration Process for Staff
Members

Excessive Sync Retry Statuses Added to Search Framework Status
Tool
PATH: System Administration > Search Framework Tool

The following statuses were added to the Search Framework Status tool:

Yellow Status – Indexing - The search index is taking longer to index than expected.
This message appears if a site is taking more than 4 hours to index.

Red Status – Indexing - The search framework is taking much longer to index than expected.
This message appears if a site is taking more than 24 hours to index.

Product Information: Search Framework Status

Campus.2112
Campus Learning - Engagement Check-In
PATH: Instruction > Control Center > smiley face icon; Scheduling > Courses > Section > Engagement Check-In

A new tool has been added to the Control Center called Engagement Check-In. This tool allows teachers to send
their students check-ins through Campus Student, which can measure their well being and engagement in class
and with assignments.

To access the tool, click the smiley face icon in the Control Center. Teachers then choose which question(s) to
ask students from a pre-determined list, who respond through the Campus Student app. Teachers can then view
and filter responses.

An administrator version of the tool has also been added to Scheduling which allows users with rights to view
check-ins for section.

Note: The new look of the Control Center must be enabled to use this tool. This tool is only available in
districts with a Campus Learning license.
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Product Information: Engagement Check-In, Engagement Check-In (Section)

Campus Instruction - Assignments Updates
PATH: Instruction > Grade Book > Add 

The following updates have been made to assignments:

Resolved an error some teachers encountered when selecting a Google Drive File with the file option set
to Copy.
Added Sequence to the assignment summary that displays in the grading tool tip in the Copier and Edit
mode.
Assignments in aligned to more than one section have been updated so that if a user clicks the name of
another section in the Other Sections area, it opens the assignment in the context of that section, as shown
in the breadcrumbs at the top of the assignment.

Product Information: Assignments

Student Information Blended Learning Group Assignments
PATH: Student Information > General > Blended Learning Groups Assignments

A new Blended Learning Group Assignments tool is available in Student Information. This new tool provides a
visual list of the student's membership in Blended Learning Groups, including current group membership and
previous group membership. Users can also print a report of a student's Blended Learning Group Assignments.

At this time, this tool is read only. Any changes to Blended Learning Groups need to be made using the Blended
Learning Group tools or modifying the assignment on the student Attendance tool.

Product Information: Blended Learning Group Assignments

Activity Registration Updates
PATH: Activity Registration 

The following updates were made for Campus Parent and Campus Student portal users.

In the Portal under Activity Registration, users could see registration records that were created via the
Roster screen when they had not been marked as paid. This issue was corrected.
If a student had more than one guardian, only the guardian that filled out/signed an Activity Registration
form could open the form. This was corrected and now the student and all guardians can open and view (in
read only mode) the Activity Registration forms after they are filled out.

Product Information: Activity Registration Workflow

Tool Rights for Student State ID, Staff State ID
PATH: System Administration > User Security > Users/Users Groups > Tool Rights
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A new Student State ID tool right and a new Staff State ID tool right is now available. Previously, the ability to
modify a state ID, whether for staff or students, was tied to the State ID tool right.

Conversion was done to assign any user who was previously assigned tool rights to the State ID tool right the
same rights to both the Student State ID tool right and the Staff State ID tool right.

When users have these rights assigned, the IDs can be included in Ad hoc Reports.

Full access to these tool rights require Read, Write and Add rights. Delete rights are not necessary.

Product Information: Census Tool Rights

Transcripts - Course Name, Course Number Original Value
PATH: Student Information > General > Transcripts 

An Original Value label displays next to the original values populated for the Course Number and Course Name
on the Transcript. Re-selecting the original value does not populate the additional fields throughout the
Transcript details that are dependent on the Course (these fields vary by state).

The Transcript has also been optimized for performance.

Product Information: Transcripts

E-Signature Now Optional for Online Applications
PATH: Application Preferences; System Administration > User Security > E-Signature

Districts are no longer required to use the E-Signature functionality in order to use online meal benefit
applications. As a result of this change, the "Meal Benefits" Online Application Preference can be selected
without activating E-Signatures on the portal.

If you choose not to activate E-Signature functionality, keep the following items in mind.

It is ultimately the responsibility of each CNP SA (Child Nutrition Program State Agency) and local agency
to review their state’s statutes and policies regarding what is required for the electronic transfer of
information in state-administered Federal programs. Know the requirements prior to activating or
deactivating E-Signature.
The standard application instructions (found in FRAM > Letter Editor > Online Application Instructions) lists
information on PIN use in several places. If you are turning off or not using E-Signatures, update the
instructions to remove reference to the PIN requirements.
There is language in the Terms of Use section of the E-Signature which mentions the electronic signature.
Consider moving the information from this section to the Authorization Statement section of the Application
Instructions if you are not using E-signature.

Product Information: Application Preferences; Activate E-Signature Functionality

Announcing New Payment Platform
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PATH: System Administration > Payments 

With this release of Campus Payments, districts can begin migrating to our new payment platform. Campus is
using a new payment platform in order to provide districts with a better user experience. After migrating, you do
not have to call a third-party for support. Instead, you can call Campus Support. The new payment platform
eliminates problems with syncing two different systems. Everything you need to do is now within Infinite Campus.

To begin the migration process, use the Payments Migration Checklist and review the Frequently Asked
Questions.

Product Information: Payments Migration Checklist; Merchant Signup

Special Ed Goal Monitoring Update
PATH: Student Information > Special Ed > General > Goal Monitoring

A new option, Use Aim Dates, has been added to the report portion of the Special Ed Goal Monitoring tool.
When marked, the Aim date range displays on the report graph.

Product Information: Goal Monitoring

Caseload Summary Report Print Format Added
PATH: Student Information > Reports > Caseload Summary 

The CSV report option has been added to the Caseload Summary Report.

Product Information: Caseload Summary Report

Campus.2108
Blended Learning - Date Logic Updates, Group Names, Summer
School, Calendar Day Selection
PATH: Scheduling > Blended Learning Groups 

The following modifications have been made to address date logic and to prepare for end of year processing for
Blended Learning Groups:

A school year must be selected in the Campus toolbar in order to create new blended learning groups or
adjust existing groups. A message displays on the landing page of the tools when a year has not been
selected.
Changing the year in the toolbar when in the middle of creating or adjusting groups returns you to the
landing page of that tool. Reopening the tool resets the dates to match the selected school year.
When creating a blended learning group, the end date entered in the New Blended Learning Group tool is
also added to the database and displays for all student
group assignment end dates associated with the group.
End dates can only be entered if it is the current date or in the future.
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End dates are required when editing or adjusting groups.
Extending a future group end date does not update the student group assignment end date.
Shortening a future group end date does update or delete any group assignment or day rotation necessary.

Blended Learning Group names can only be used one time per school year. That means Blended Learning
Groups in the 2019-2020 school year could match Blended Learning Groups in the 2020-2021 school year, but
two Blended Learning Groups named the same in the same school year is not possible.

A new Exclude Summer School Calendars checkbox has been added to the New Blended Learning Groups tool.
When marked, any summer school calendar (Summer School checkbox is marked on the Calendar Information
editor) is ignored when Blended Learning Groups are created (step 2. Group Day Rotation).

Users could not remove a Blended Learning Group from a current or future date in Calendar Days. This has
been corrected.

Product Information: New Blended Learning Groups, Adjust Blended Learning Groups, Manage Blended
Learning Groups

Blended Learning - Gap and Overlap Report
PATH: Scheduling > Reports > Blended Learning Gap/Overlap

A new Gap and Overlap Report has been added to Scheduling Reports. This report identities a date range
where the student is not assigned to a Blended Learning Group (gap) or is assigned to multiple Blended
Learning Groups (overlap).

The report can be generated for both gaps and overlaps, for just gaps, or just overlaps.

Product Information: Blended Learning Groups Gap and Overlap Report

Teacher Schedule Batch
PATH: Scheduling > Reports > Teacher Schedule Batch 

A new List format and an option to include the Teacher Display Name has been added to the Teacher Schedule
Batch.

The List format prints the courses by term and day.
When the Teacher Display Name option is marked, the report prints the name of the teacher as entered
from the Teacher Display Name field on the Section editor.

Product Information: Teacher Schedule Batch

Embeddable Content - Students
PATH: Campus Student > Assignment

LTI partners who have "Embeddable Content" enabled are now available for students to use when submitting
assignments through Campus Student. Once the Embeddable Content partner is enabled in Digital Learning
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Partner Applications Configuration, students can embed content by clicking the + sign in the WYSIWYG editor of
an assignment and selecting the partner.

Product Information: Campus Student

Transcripts - Add Rows Modal
PATH: Student Information > General > Transcripts

The Add Rows modal now automatically populates fields based on previous selections.

Product Information: Transcripts

Activity Registration Updates
PATH: System Administration > Portal > Preferences > Display Options 

Parents and Students can now view Activity Registration information including all forms associated with an
activity in Campus Parent and Campus Student. The Activity Registration area in the portal includes a link to the
School Store where users can register for activities. As part of this change, an Activity Registration section was
added to the Portal Preferences > Display Options with a new option called "Enable Activity Registration Viewing
tool." This option must be selected for users to see the Activity Registration area in Campus Parent and Campus
Student.

The "Active" status in the Activity Monitor and Activity Builder was split into two separate statuses:

Active - Registration Open
Active - Registration Closed

This change allows users to update the "School" field when an activity is active as long as registration is still
open.

In Campus, when a user locks or completes a form in the Activity Monitor, Campus now automatically returns the
user to the Roster screen instead of making them click "Cancel" to exit the form.

Product Information: Activity Registration Workflow; Display Options

New Health Office Visit Cancellations Tool
PATH: Health > Health Office Visit Cancellations

A new tool, Health Office Visit Cancellations, has been added to allow users to batch cancel all previously
scheduled, unsaved Health Office Visits when there have been canceled School Days. This tool has a separate
tool right and needs to be manually given to appropriate users.

Product Information: Health Office Visit Cancellations

Tool Rights Updated to Match New Look and Feel of Infinite Campus
Navigation Structure
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PATH: System Administration > User Security > Users > Tool Rights

Tool rights in the New Look and Feel of Campus have been updated to match the new navigation structure.
Existing tool rights between Classic Campus and the New Look of Campus should match and require no
additional user intervention however, any rights changed after updating to Campus.2108 are at a user's
discretion and maintenance.

The tool rights editor in the New Look of Campus has been enhanced to include a search feature, allowing you
to narrow the tool rights list by search criteria. There is also a new Tag Filters area, allowing you to quickly filter
out administrative tools to make adding teacher and staff tool rights easier. To view administrative tools, simply
remove the Non Admin tag filter.

Product Information: Define User Tool Rights

Process Inbox Messages Added for Search Framework Status
PATH: System Administration > Search Framework Status 

Process Inbox messages have been added to alert SIS administrators of issues encountered with their Search
Framework, as well as when these issues have been resolved. These messages include a brief description of
the issue and links to the Search Framework Status tool for further investigation. Once an issue has been
resolved, a message is sent indicating success and the action successfully performed.

For details about each Process Inbox message you may encounter, see the Search Framework Status tool
article in the Campus Community Knowledge Base.

Product Information: Search Framework Status

Ability to Lock Custom Menu Items, Categories, and Tools Added to
Custom Tool Placement Editor
PATH: System Administration > Custom > Custom Tool Placement Editor

A Lock toggle has been added to Menu Item, Category, and Tool editors within the Custom Tool Placement
Editor to allow users to lock these items and ensure they cannot to be edited or deleted by any users (including
the user who set the toggle).

Note: Once locked and saved, locked items cannot be modified or deleted unless done in the backend

Product Information: Custom Tool Placement Editor

Online Meal Benefits Application Update
PATH: Campus Parent > More > Meal Benefits Application 

On the step where applicants confirm child household members, the child checkbox next to the signer is now
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disabled if the signer does not have an assigned school. This change was made to help prevent parents from
accidently marking themselves as children on the application. As part of this change, a pop-up confirmation
message now displays between the Children and Gross Income steps if there are people marked as children and
do not have a school listed. Users can return to the household step to fix mistakes or move forward if correct.

Product Information: Meal Benefits Application (Portal)

Third-Party Password Breach Notification Functionality Added for
LDAP Users
PATH: System Administration > User Security > User Preference Management > Account Security Preferences

The ‘Prohibit Passwords That Have Been Previously Disclosed in a Data Breach’ account security preference
has been updated to also apply this functionality to Campus user accounts using LDAP authentication.

When enabled, users who attempt to log into Campus via LDAP using a password which matches a password
found in a publicly known third-party data breach will automatically receive notification of this issue and be asked
to change their password.

This feature is optional and not automatically turned on or mandated by Infinite Campus

NOTE: Notification of a breached password DOES NOT mean your Infinite Campus account has been
breached. It means your password matches a password found in a global database of breached passwords
from third-party systems who have had a known data breach.

Product Information: Account Security Preferences

Ed-Fi Enhancements and Bug Fixes
PATH: System Administration > Ed-Fi

The following updates have been made to Ed-Fi:

The Resource Preferences toggle was previously not working with some new configurations. This issue
has been corrected.
Unmapping grading tasks in Grades would previously cause there to be grading periods with an empty
grading task. This issue has been corrected.
All course-based resources can now be resynced by course or section.
Grading Periods are now based on school year instead of hard coded.
The Resync tool was not deleting Student Parent Association records in version 3.3. This issue has been
corrected.
An issue with resyncing within the Ed-Fi Data tool for Wisconsin has been corrected.
The Parent and Student Parent Association resources have been updated to look at the district instead of
application to determine deletes.
An issue with deleting grading periods from the grading mappings has been resolved.
An issue with setting Resource Preferences when there was an invalid connection has been corrected.
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Product Information: Resync (Ed-Fi), Ed-Fi Data

Campus.2104
Improved Assignment Editor and New Curriculum Tools
PATH: Instruction > Grade Book > Add button

This release includes a redesigned of the assignment editor as well as new curriculum tools, including resources
and folders. The visual changes apply to all Instruction users; teachers need the Enhanced Curriculum Editor
tool right to use the new features.

Assignments Editor
Instruction tools have been updated with a new and improved assignments editor, which simplifies and clarifies
the process of creating assignments. All of the familiar fields and options are available, just rearranged and
redesigned into a clearer, easier-to-use editor. Section Settings, Grading, and Other Sections are grouped
clearly with additional enhanced curriculum features on the left.

For users without Campus Learning or the Enhanced Curriculum Editor tool right, the basics of an assignment
display in a side panel.

With Campus Learning and the Enhanced Curriculum Editor tool right, additional options display on the left side
of the editor.

Enter Summary text in the WYSIWYG editor.
The Attach Content includes options for adding additional resources to the assignment and is dependent
on district setup. Any additional content can be set to display to students and teachers, or only to other
teachers viewing the assignment.
The Add a Task section collects the options for student interaction, including a aligning a discussion, a quiz
(formerly Quick Assessment) or a submission.
The Preview button at the bottom of the assignment shows teachers exactly how the item will look for
parents and students.

To add an assignment, click the Add button in any assignment tool, such as the Grade Book or Progress
Monitor. Click the arrow next to the Add button to add a Resource or Folder (described below) or to create an
assignment starting with the Discussion, Quiz, or Submission portion.

New - Resources
Resources are basically assignments that will not be scored. For resources, the Grading section of the editor is
toggled off; switch an item from an assignment to a resource and back using the Grading toggle.

Resources provide greater flexibility in the content provided to students. Create a resource to distribute a
syllabus to your students within Campus, to share reference materials, to facilitate a test prep discussion that
isn't scored, or poll students using an informal poll that won't be scored.

To create a Resource, click the arrow next to the Add button in the Grade Book or any other assignment view
and select Resource in the dropdown list.
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Structuring Curriculum
With this release, Campus has retired the "Unit" and "Lesson Plan" items and replaced them with Folders.
Folders are more flexible, allowing teachers to organize and nest folders to best suit their curriculum and
students. A folder could be used to represent a week of the course, a unit of the material, or any other useful
grouping, such as a Course Resources folder that collects course-wide and commonly used resources.

To create a Folder, click the arrow next to the Add button in the Grade Book or any other assignment view and
select Folder in the dropdown list.

Existing units and lesson plans have been converted into folder, nested folders, and resources, preserving the
existing structure.

Improved Navigation
Great improvements have been made to the Curriculum List to simplify and streamline the view. All items for the
section display, regardless of the current context. Icons indicate Folders, Resources, Assignments, and other
types of content. Search all items in a section using the search bar at the top of the list.

Click a folder to view its child folders, resources, and assignments. Click an item to view a read-only version of it,
and then click Edit to make changes. Click the arrow next to Edit and select Move to add an item in a folder.
When viewing an item, the curriculum hierarchy is clearly visible along the top of the editor; click an item to view
it.

With this change, the curriculum library is not currently available to teachers. An improved library will be
available in an upcoming release. In the mean time, use the Other Curriculum tab in the Planner to add
curriculum from another section. Simply search for the section that has the desired curriculum to add it to
Other Curriculum, click the name of the section and then Curriculum List to view items and Copy them to
your section.

Product Information: Assignments & Resources, The Basics: Assignment; Curriculum List

Redesigned Control Center & New Student Questions
PATH: Instruction > Control Center

The Control Center has been revamped to improve design and usability. Class periods now display in tiles which
include frequently used tasks. Customize a period by clicking the gear icon and entering a name (which only
displays here in the Control Center) and an icon and color scheme to help differentiate among your classes.

The process to take attendance and score assignments from the Control Center is unchanged. Click the person
icon, the first button in a class's tile, to take attendance. Click the paper icon to view and score students'
assignments. Campus Learning users also have a discussions button, which opens the existing discussions tool
in a side panel for easier access.

If enabled by the district and then by the teacher, a hand icon may also display for the new Student Questions
tool. Districts enable this tool using the "Student Questions in Campus Student" display option in the Portal
Preferences. If enabled, teachers see an "Enable Student Questions" checkbox in the Control Center Settings
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(gear icon). Once enabled, this tool allows students to ask questions from Campus Student which teachers can
respond to here in the Control Center.

When a student asks a question, an orange notification dot displays over the hand icon. Click the icon to view
the student's question and respond. Once you reply or dismiss the question, it disappears from your view. 

Product Information: Control Center, Student Questions

Virtual Attendance - Moving Students from Physical to Virtual
PATH: Campus Instruction > Attendance > Physical Override

If the new 'Allow teacher to move physical students to virtual' virtual attendance preference is marked, teachers
will see a Physical Override button in Attendance. Teachers can click this button to view a list of students who
are scheduled to attend physically and mark any who have decided to attend virtually.

Once this override is saved, any physical attendance recorded by the teacher for the student that day will be
cleared and the student will be marked as Participated, which cannot be removed. To switch a student back to
physical, reopen the Physical Override list and unmark the student, which marks them as Present on the
attendance screen.

Product Information: Taking Attendance with the Roster

Sub Attendance Roster - Blended Learning Groups
PATH: Attendance > Reports > Sub Attendance Roster

The Sub Attendance Roster Report has been modified to include Blended Learning Groups when is use at a
school.

Student names on the report are organized by either Physical Students or Virtual Students sections. These
sections are determined by the entered Effective Date on the report editor and depends on the selected Virtual
Attendance Preferences. 

Product Information: Sub Attendance Roster

LTI Launch Types - Embeddable Content
PATH: System Administration > Learning Interoperability/Digital Learning Applications > click an LTI partner

A new launch type has been added for LTI connections called Embeddable Content. This launch type allows
teachers to embed images from a digital learning partner in the WYSIWYG editor of an assignment. If
Embeddable Content is available for a digital learning partner, an Embeddable Content lozenge displays in the
Learning Interoperability/Digital Learning Applications tool.

Product Information: LTI Configuration

Activity Registration Updates
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PATH: Activity Registration > Activity Monitor

The following changes were made for Activity Registration.

Users can now preview roster information in a side panel on Step 2 in the Activity Builder. The panel
displays an estimate of the total number of students listed by school then provides the student's names.
A new filter called "Registration Status" was added to the Activity Roster. Users can select one of the
following statuses to limit which registrations display: All, Waiting Signatures - Required Forms, Action
Needed - Required Forms, Optional Forms - In Progress, or Required Registration Complete.
Districts can now update the Registration Close Date on an activity (Step 1 in the Activity Builder)
throughout the duration of the activity - up to and including the Activity End Date.
Miscellaneous changes were made for general maintenance. 

Product Information: Activity Monitor and Activity Roster

Refresh Functionality Added to Search Framework Status Tool
PATH: System Administration > Search Framework Status

A Refresh button has been added to the Search Framework Status tool, allowing users to refresh the status of
the Search Framework Status tool at any time. 

Product Information: Search Framework Status

Campus Domain URLs Added to iFrame Allowed List for
Announcements
PATH: User Communication > Announcements

Infinite Campus domain URLs have been added to the iframe src filter allowed list, enabling users to use
Campus domain ULRs (such as Knowledge Base articles) in iframes within announcements. 

Product Information: Announcements

Minimum Password Length Account Security Preference Added
PATH: System Administrator > User Security > User Preference Manager > Account Security Preferences

A Minimum Password Characters preference has been added to Account Security Preferences. This preference
allows districts to set the minimum number of characters required for Infinite Campus account passwords. If the
preference is left blank, a default value of 6 characters is used. 

Product Information: Account Security Preferences

Messenger (Email)– New ‘Sender Display Name’ field added to
multiple Messenger (Email) tools
PATH: Messenger > Message Builder; Messenger > Staff Messenger; Messenger > Emergency Messenger;
System Administration > Messenger > Messenger Preferences > Email Settings
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Sender Display Name has been added to multiple Messenger tools allowing users to customize what recipients
see in their email inbox. This field remains hidden until enabled in Messenger Preferences > Email Settings and
‘Email’ has been selected from the Messenger template’s Delivery Device options. Sender Display Name can be
enabled in the following Messenger tools:

Message Builder
Staff Messenger
Emergency Messenger
Campus Instruction Messenger 

Product Information: Message Builder, Staff Messenger, Emergency Messenger, Email Settings

Payments Reporter Update
PATH: System Administration > Payments > Payments Reporter

A new column called "Settlement Date" was added to the Payments Reporter tool. The Deposit Date field on the
Payment Transaction panel was also renamed Settlement Date. 

Product Information: Payments Reporter

SFTP Protocol Option Added to FRAM Scheduled Imports
PATH: FRAM > Eligibility Import Wizard > Scheduled Imports

The option to use SFTP was added to the FRAM Scheduled Imports tool. When SFTP is chosen in the Protocol
dropdown list, the default value *22* displays in the Port field. This number can be changed. 

Product Information: Scheduled Imports

Campus.2052
Activity Registration Updates
PATH: Activity Registration > Activity Monitor

The following changes were made for Activity Registration.

Changes were made to allow an activity to be purchased in Campus Parent when the student has multiple
guardians and the forms have been manually updated in the Activity Roster.
The Post to Course section process was not displaying the correct school calendar when more than one
school was on the activity. This issue was corrected.
The Ad hoc Filter Designer was updated to prevent users from deleting an Ad hoc filter if it is associated
with a School Store Product or an Activity.
The selection (on or off) for the Registration Confirmation Process toggle is now retained when users exit
and return to the screen. 
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Product Information: Activity Monitor and Activity Roster

Survey Designer Updated to Update Respondents List Based on
Calendar Selected
PATH: Surveys > Survey Designer > Add Respondents

The Add Respondents feature of the Survey Designer tool has been updated to refresh the respondents list
whenever a new calendar is selected. 

Product Information: Survey Designer

Survey Designer Updated to Allow Selecting Respondents by Section
PATH: Surveys > Survey Designer > Add Respondents

The Survey Designer has been updated to include a simple way to add students from a course/section roster as
survey respondents. Now, when adding respondents, users can select a filter option of Section Roster and filter
the list of students available by Term and Section. 

Product Information: Survey Designer

Enabled/Expect Enabled Indices Column and Two New Statuses
Added to Search Framework Tool
PATH: System Administration > Search Framework Status

The Enabled column on the Indices table has been renamed to Enabled / Expect Enabled and now indicates
whether or not each indices is enabled and whether or not it should be enabled.

Also, a yellow status has been added which indicates when at least one index should be disabled but is currently
set to enabled and a red status has been added which indicates when at least one index should be enabled or
initialized but is currently set to disabled or not initialized. 

Product Information: Search Framework Status

Password Minimum Retention Period Preference Added
PATH: System Administration > User Security > User Preference Management > Account Security Preferences

A new preference called ‘Password Reset Disallowed Time’ has been added to the Account Security
Preferences tool. This preference allows administrators to set the minimum amount of hours that must pass
between password reset requests for a user. If left blank, this preference is disabled. 

Product Information: Account Security Preferences

LDAP Disabled Account Notification Added to Infinite Campus Login
Page
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PATH: Infinite Campus Login Page

A notification message has been added to the Infinite Campus login page, notifying LDAP disabled user account
holders their account is disabled each time they attempt to log in. 

Product Information: N/A

Ed-Fi Data Tool Updates
PATH: Student Information > General > Ed-Fi Data, System Administration > Ed-Fi > Configuration

The following updates have been made to the Ed-Fi Data tool:

The Ed-Fi Data tool will display any errors that are active in the Error Log for the selected student.
A resync can be performed from the Ed-Fi Data tool.

Please note that a resync from the Ed-Fi Data tool will not include any dependencies.
When a resync is performed, all errors for the selected student that are in the Error Log for the selected
resources will auto-archive.
A Unique Identifier for both Ed-Fi and Infinite Campus information has been added for every resource.
A Campus Identifier has been added for Infinite Campus information for every resource.
The Delete button has been added to the Ed-Fi Certificate tool.

Product Information: Ed-Fi Data

Tally Meal Entry Edit Check Report
PATH: Point of Sale > Reports > Edit Check

The Tally Meal Entry version of the Edit Check report is now available for CEP schools or schools that record
meals in bulk using the Tally Meal Entry tool. The Tally Meal Entry tool must be used in order to generate this
report. This version of the report prints school level summaries of enrollment and total meal counts grouped by
the purchasable items’ Federal Program. 

Product Information: Edit Check Report

Multi-Day Serve
PATH: N/A

To support school's COVID-19 food distribution needs, a new feature called "Multi-Day Serve" was added to the
Campus Point of Sale. Multi-Day Serve allows schools to hand out meals for multiple days using a single
transaction on the point of sale. This eliminates the need for manually entering daily meals. Eligibility rules are
still followed and meals can still be verified using the Edit Check report. Students are charged for the meals on
the day the meal was meant to be served to them, not necessarily on the day they received the meal. Multi-Day
Serve can be run with the terminal offline or online.

To use this new feature, cashiers can select "Multi-Day Serve" on the Menu Control screen. The Multi-Day Serve
screen allows cashiers to search for the patron, select the purchasable items, and select the days on which the
meals should be processed. 
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Product Information: Multi-Day Serve (Process Patron Transactions)

Campus.2048
Blended Learning Updates
PATH: Scheduling > Blended Learning

The following modifications have been made to Blended Learning tools:

To provide a cleaner interface for New Blended Learning Groups, a new side panel has been added where
learning groups can be edited. This includes modifying the name of the group, updating the group color, adding
an end date for the group, and marking the group as active or archived.

Blended Learning Group Assignments can now be assigned to calendar days in the past. The selected
group must be active in order to be assigned. Group Day assignments can be added but not removed.
Users can now hide archived groups from the main view of New Blended Learning Groups, Adjust Blended
Learning Groups and Manage Blended Learning Groups.
A group can only be backdated to the earliest attendance date. When the Group Start Date is already
equal to the earliest attendance date, an error message displays.
When creating new automatic groups, a new message displays if a gap is detected in the group
assignments. Group day rotations will need to be manually adjusted.
Updated alert messages have been added to provide clarity when database connection has been lost
during the group creation process.
Removing a Group End Date now also removes the end date on the Student Group Assignment.
When adjusting the student group assignment, changing the selected group now updates the list of
students in that group. 

Product Information: Blended Learning Groups

Attendance - Participation Fill Options
PATH: Campus Instruction > Attendance 

The Fill Comment and Fill Participation Type options on the Attendance screen have been updated to allow
teachers to filter the fill by students who have and have not participated. 

Product Information: Taking Attendance

Blended Learning - Walk-In Scheduler Group Counts
PATH: Student Information > General > Walk-In Scheduler

The total count of students in a Blended Learning Group now displays when hovering over active grid sections in
Walk-in Scheduler. The hover shows the Room Number, total number of students with an IEP, and the Blended
Learning Groups with a count of students in each group. 

Product Information: Walk-In Scheduler
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Activity Registration Updates
PATH: Activity Registration > Activity Monitor

The following changes were made for Activity Registration.

Activity Registration now supports interactive custom forms. Interactive forms allow users to enter data
directly into the PDF and electronically sign when registering for an activity. A request for data and/or
signature can be sent to the student and/or parent/guardian(s) on the Campus Parent and/or Campus
Student portal. Campus Student and Campus Parent portal will notify the user if there are required forms
that must be completed or before the activity is added to the School Store cart. If you use an interactive
form, you can also use the following Ad hoc fields to prepopulate the form: "activityName" and
"studentFirstLastName." For more information about creating interactive forms, see the Custom Forms
article on the Infinite Campus Knowledge Base.
The Activity Roster was updated to allow viewing the forms associated with each student. Districts can see
eSignatures and enter a contact log. A Lock/Unlock button is also available on the form. A locked form
indicates no additional changes can be made. While district staff cannot sign for students/parents, the
eSignature can be overridden.
When you manually add a student to the roster, all forms must be reviewed and if applicable sent for
eSignature. Forms can then be filled out in the Campus Student and/or Campus Parent Portal in the
Documents tool. District staff can also fill out forms (except for the eSignature) in the Activity Roster if
necessary.
The "School(s)" field on step 1 of the Activity Builder is now unlocked and can be modified until the
Activity's status is Registration Closed. 

Product Information: Activity Builder; Activity Monitor

School Store - Sale Price Now Displays on Pick List
PATH: School Store > Reports > Pick List

A new column called "Sale Price" is now available on the Pick List report. This column displays the price the
buyer paid for the item they purchased. The Sale Price could be the selling price, the reduced price, or the free
price. Users cannot see the Sale Price column until your administrator assigns the new "Show Payment
Amounts" tool right to them. This tool right is found under School Store > Reports > Pick List > Show Payment
Amounts.

This case also included the following miscellaneous changes.

The Picked Up checkboxes were not disabled when the user only had read rights. This issue was
corrected.
The filter icon was removed from the columns on the Sales report.

Product Information: Pick List

School Store - Orders Report PDF Format
PATH: School Store > Reports > Orders
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The Orders report can now be generated as a PDF file. The PDF version of the report includes the same options
for grouping report results as the CSV and Labels-Large formats. If your district uses Point of Sale, the PDF
report also includes the student's PIN and barcode if there is an account PIN on the student's record.

Product Information: Orders Report

School Store - Update for Categories with No Active Products
PATH: N/A

Changes were made to ensure Categories with NO active products do not display in Campus Parent and
Campus Student.

Product Information: Campus Parent; Campus Student

School Store - New Shop by Categories Option
PATH: School Store > Administration > Settings

A new option called "Shop by Categories" was added to the Settings tool. When this new option is selected,
Campus Parent and Campus Student users will first see categories instead of all the products when they enter
the store.

Product Information: Settings

Special Ed Caseload Update
PATH: Student Information > Special Ed > Caseload 

A case manager and service provider count has been added the Special Ed Caseload.

Product Information: Special Ed Caseload

Goal Monitoring Graphing Functionality Added
PATH: Student Information > Special Ed > General > Goal Monitoring

A graphing function has been added to the Goal Monitoring tool to allow users to see the student's progress over
time towards their Special Education goals.

Product Information: Goal Monitoring

User Group Name Added to Filter Name in Survey Designer Tool
PATH: Surveys > Survey Designer

The Add Respondents editor in the Survey Designer tool has been updated to now display filters as User Group
Name – Filter Name to assist in users distinguishing between filters with similar names assigned to different user
groups.
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Product Information: Survey Designer

Data Analysis Pivot Added to Survey Response Extract
PATH: Surveys > Reports > Response Extract

The ability to generate Survey Response data into a pivot table has been added to the Response Extract. Now,
users can click the Generate Data Analysis Report button to open data inside a pivot table for further analysis
and visualization.

Product Information: Response Extract (Survey)

Password History Length and Password Expiration Time Options
Added to Account Security Preferences
PATH: System Administration > User Security > User Preference Management > Account Security Preferences 

The Password History Length and Password Expiration Time fields have been added to the Account Security
Preferences tool. The Password History Length field allows you to determine the number of previous passwords
a user cannot use when changing their password. The Password Expiration Date field allows administrators to
determine how long a password is valid before the user is required to change it.

Product Information: Account Security Preferences

App Instances Table Added to Search Framework Status Tool
PATH: System Administration > Search Framework Status

An App Instances table has been added to the Search Framework Status tool. This table tracks a list of Campus
app servers and the last time they successfully registered with the search framework. If Campus is hosted
across multiple app servers, then each of those app servers phones home and registers with the search
framework on a daily basis. It is possible for users to experience search framework issues across all apps or only
specific apps.

Product Information: Search Framework Status

Third-Party Password Breach Notification Added
PATH: System Administration > User Security > User Preference Management > Account Security Preferences 

Infinite Campus has been updated to read and utilize a global database used to track passwords and accounts
affected by data breaches of non-Infinite Campus systems. A new 'Prohibit Passwords That Have Been
Previously Disclosed in a Data Breach' preference has been added to the Account Security Preferences tool.
When enabled, if Infinite Campus detects a user's password matches a password found in a publicly known data
breach, it will automatically notify the user and recommend they update it.

This feature is optional and not automatically turned on or mandated by Infinite Campus
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NOTE: Notification of a breached password DOES NOT mean your Infinite Campus account has been
breached. It means your password matches a password found in a global database of breached passwords
from third-party systems who have had a data breach.

Product Information: Account Security Preferences

District-Wide Searching Added to New Look and Feel of Infinite
Campus
PATH: N/A

The New Look and Feel of Infinite Campus has been updated to allow for district-wide student searches.

Product Information: Try the New Look of Campus

New Tally Meal Entry Tool
PATH: Point of Sale > Account Maintenance > Tally Meal Entry

The new Tally Meal Entry tool provides the ability for a school to record a count of meals served to students.
Counts are recorded according to the school in which the student is enrolled to allow for comparison to
attendance data. This tool can be used to easily track meals at CEP schools.

Product Information: Tally Meal Entry

New Tally Meal Entry Tool
PATH: Student Information > General > Ed-Fi Data, System Administration > Ed-Fi oint of Sale > Account
Maintenance > Tally Meal Entry

The Ed-Fi Data tool has been made available to allow districts to compare student related Ed-Fi resources with
the data that is in Infinite Campus. An Ed-Fi JSON for the selected resource can also be viewed from this tool.

The following Ed-Fi updates have also been made:

The Resync tool has been updated to make the All People checkbox and Person ID field not required when
resyncing non-person related resources. The Resync tool has also been updated to not select optional
resources when the Select Dependencies checkbox is checked. The Select Dependencies checkbox will
not be checked by default.
A Grades records error that was occurring due to the incorrect beginDate pulling in the Student Section
Association Reference has been fixed.
The trigger logic for the Grading Periods resource has been updated to delete the resource when the last
remaining day in the day table is deleted for a school.
The totalInstructionalDays element in the Grading Periods resource has also been updated to report when
the instructional day checkbox is checked or unchecked. If all days are marked as non-instructional, the
element will report ‘0’. The totalInstructionalDays element has also been updated to report the distinct
number of instructional days from all calendars/schedule structures that have a specific grading period
(same school, descriptor, and sequence) when there are multiple calendars and/or schedule structures.
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The resync logic for the Grading Periods resource has been updated to not send the resource when there
are no days in a calendar.
The removal of a mapped entry over an empty entry in the Resource Preferences has been fixed.
The resync queries have been updated to check configuration dates rather than hard-coded dates.
A bug that was occurring in the Economic Disadvantaged characteristic in the Student Education
Organization resource has been fixed.
An error that was occurring in the Parents resource and multiple keys has been fixed.
The Calendar Delete tool has been updated so that no errors appear in the Error Log when the tool is run
on a calendar that exists in Swagger. An update has also been made so that the Calendar resource is
deleted when a calendar is deleted from Infinite Campus.
The Ed-Fi Error Log has been updated to log errors from the Delete Tool with invalid EdFiIdentityIDs.
An Import Certificate button has been added to the Connection Detail page to import a certificate from the
ODS based on the API URL.
A School filter and All Schools checkbox has been added to the Ed-Fi Identity Mapping tool to allow
districts to filter results by school.

Product Information: Ed-Fi Identity Mapping, Ed-Fi Configuration Tool

Campus.2044
Grading Setup Changes
PATH: Scheduling > Courses > Grade Calc Options, Categories 

A message has been added to the top of the Course > Grade Calc Options and Categories tools that states
"Changes made here must be pushed to sections from the Course Information tool."

A message was also added to the Course Master > Grade Calc Options and Categories tools that states
"Changes made here must be pushed to sections from the Course Master Information tool."

Product Information: Grade Calc Options (Course), Categories (Course)

Attendance - Blended Learning
PATH: Campus Instruction > Attendance; System Administration > Custom > Attribute Dictionary

The Attendance tool has been updated to allow teachers to fill Participation Comments.

Additionally, a new Participation Type field has been added to the Attribute/Dictionary, which can be enabled and
used to track Synchronous and Asynchronous attendance.

Product Information: Attendance

Blended Learning - Ability to Backdate Groups
PATH: Scheduling > Blended Learning > Manage Blended Learning Groups 

A new Manage Blended Learning Groups tool is now available. This tool allows users to change the start date of

Copyright © 2021 Infinite Campus. All rights reserved.



Blended Learning Groups to an earlier start date. Groups can be backdated with or without student assignments.

This new tool backdates the start date for the Blended Learning Group. Backdating a single student's start date
in a particular group can be done from the Student Attendance tool.

Product Information: Manage Blended Learning Groups

Student Attendance - Ability to Backdate Blended Learning Groups
PATH: Student Information > General > Attendance

The Student Attendance tool now allows the ability to add a start date in the past for the student's blended
learning group. This requires users to be assigned Read rights to the *Can Backdate Blended Learning Group*
sub-tool right.

When a student has an assignment for another Blended Learning Group that begins in the future, an alert
displays asking if that assignment should remain.

When a student moves from a virtual group to a non-virtual group for any date within the affected range of
Assignment Start Date to the current date, participation records for that date are removed.

When a student moves from a non-virtual group to a virtual group for any date within the affected range of
Assignment Start Date to the current date, participation records are added for that date for Tardy, Present, Early
Release attendance events, and for days where the student does not have attendance events, unless that day is
not considered an attendance day or the course is not marked for attendance.

This feature allows the backdating of a Blended Learning Group for a single student. Use the Manage Blended
Learning Groups tool to backdate the start date for many students assigned to a Blended Learning Group.

Product Information: Attendance (Student)

Classroom Attendance, Section Attendance - Confirm Student
Participation
PATH: Attendance > Classroom Monitor; Scheduling > Courses > Course > Section > Attendance

Attendance Office staff can now enter and modify participation for virtual students via the Classroom Monitor and
the Course Section Attendance in Scheduling, as long as Virtual Attendance is enabled with Participation-Based
Entry selected.

Product Information: Classroom Monitor; Section Attendance

Test.endYear Added to Filter Designer and Data Viewer
PATH: Ad Hoc Reporting > Filter Designer, Data Viewer 

The Test.endYear field is now available in the Filter Designer and Data Viewer tools.

Product Information: Filter Designer; Data Viewer
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Student Transcripts
PATH: Student Information > General > Transcripts; Student Information > Counseling > General > Transcripts

In the Campus.1745 (November 2017) Release, a new Student Transcript was released. Since then, two options
of the Student Transcript were available – one in Student Information > Counseling (the new Transcript) and one
in Student Transcript in Student Information > General (the original Transcript). In this release, the original
Student Transcript has been removed and replaced with the new Student Transcript available in Student
Information Counseling.

The new Student Transcript is now available in the New Look of Campus, as is the eTranscript Release Setup.

When using the Classic View of Campus, Transcripts can be accessed from either Student Information >
General > Transcript OR Student Information > Counseling > General > Transcripts.
When using the New Look of Campus, Transcripts are ONLY available in Student Information > General.
Enter the word Transcripts in the Search bar to access student transcripts. Users must have tool rights
assigned to Student Information > General > Transcripts for the Transcripts tool to display in the new
navigation.

Existing tool rights to both Transcript tools is used to determine access and the highest access assigned is
respected. If a user is assigned RWA to the original Transcript and RWAD to the Counseling Transcript, the user
has RWAD to the Transcript in both locations.

The original Transcript included a Free Form tool right that allowed users to enter values for course name and
number and school name and number that were not included in the school’s course catalog (e.g., when a
student transfers and transcript records are added with the original school’s course details). This tool right is now
available in the new Transcript.

Several new features have been added to the Student Transcript, as follows:

A loading icon displays when the Transcript is loading. Note that depending on the amount of transcript
records available, the length of time for it to load may vary.
The Transcript displays in a read only mode. To update an existing record, click anywhere on the row to
open the detail view of that record or use the Edit button to make quick edits to the fields available on the
grid. To add a new record, use the New Details button. The ability to edit a Transcript record requires Read
and Write tool rights.
Use the Add Row option to quickly add new records to the Transcript. This functions like the Batch Add
feature on the original Transcript. This option is available after selecting the Edit button. When a user adds
multiple rows but doesn’t populate any of the fields, those blank rows are deleted upon saving.

The following issues have also been addressed:

Localized fields on the Course editor that are used for state reports now remain marked on a student’s
Transcript in the Additional Information editor and post properly with a student’s score for a transcript
record.
Alert text is now aligned properly within the alert box.
When a user leaves a required field empty, an alert displays indicating it’s a required field when the user
leaves the field. Previously, the alert displayed when first clicking into the field.
When adding a new transcript record or modifying an existing transcript record, the incorrect date of the
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record displayed, but was saved correctly in the database. This was due to the day of month not being a
valid day in the month in which the record was created. This has been corrected.
Performance of the Transcript has been optimized when modifying or adding a record.

Product Information: Transcripts

Update for Checking Calendar Rights
PATH: Activity Registration > Activity Monitor; Activity Builder

The Activity Monitor and Builder now verify the user has access to future calendars, associated with the activity,
in order to edit activities.

Product Information: Activity Monitor and Activity Roster; Activity Builder

Jobs Table Added to Search Framework Status Tool
PATH: System Administration > Search Framework Status 

A Jobs table has been added to the Search Framework Status tool. This table allows administrators to view
information on existing Quartz jobs relevant to the search framework; including the name of each job, the job’s
status, trigger name, and trigger status.

Product Information: Search Framework Status

Tracked Tables Section Added to Search Framework Status
PATH: System Administration > Search Framework Status 

A Tracked Tables section has been added to the Search Framework Status tool. This section allows you to
monitor whether or not change tracking is enabled for each table.

The search framework relies on Microsoft Change Tracking to detect when data has been changed in the
Campus datasource. In order for search contexts to provide the most recent and accurate data, change tracking
needs to be enabled and working properly for each table shown in the Tracked Tables section.

Product Information: Search Framework Status

Double Quotes Support Added to Data Extract Utility Tab Delimited
Files
PATH: System Administration > Data Utilities > Data Extract Utility

An Include Double Quotes option has been added to the Data Extract Utility to support the use of double quotes
in the text of tab delimited files.

Product Information: Data Extract Utility

Data Extract Utility Now Available in State Editions of Infinite Campus
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PATH: System Administration > Data Utilities > Data Extract Utility

The Data Extract Utility is now available within State Editions of Infinite Campus.

Product Information: Data Extract Utility

Daily Health Survey
PATH: Student Information > Health > General > Daily Health Log; Surveys > Survey Designer 

A configurable survey template has been created for all districts that would like parents to enter Daily Health Log
data directly via the Campus Portal. Information from the survey will be automatically imported to the Daily
Health Log tab when the survey has been completed. Districts that have licensed Events & Actions may
customize the import logic further.

Districts that do not want to use the Daily Health Log survey can disregard or delete the survey.

Product Information: Daily Health Log, Daily Health Survey

School Store Cosmetic Updates
PATH: Campus Parent/Campus Student > School Store

Cosmetic updates were made to improve the appearance and usability of the School Store in Campus Parent
and Campus Student.

Product Information: School Store Getting Started for Parents

Fillable Custom Forms on Portal
PATH: System Administration > Custom Forms; Student Information > General > Forms; Portal > Documents 

Users now have the ability to send a Custom Form to parent/guardian(s) and/or student(s) to the Portal to be
electronically filled out.

Product Information: Custom Forms; Forms; Custom Forms using eSignature;Campus Parent Portal; Campus
Student Portal

Reset Account Settings Button Now Also Resets Two Factor
Authentication
PATH: System Administration > User Security > Users > User Account

The Reset Account Settings button on the User Account tab has been updated to now also reset a user's two
factor authentication configuration.

Product Information: User Account

Search Contexts Updated to Sort Alphabetical for Single Character
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Searches
PATH: N/A

Search contexts within Campus have been updated to sort results alphabetically (instead of best match) when a
single character search is performed. For course/section and course master searches, if the single character
search is a number, results are sorted by numeric matches.

Product Information: Try the New Look of Campus

New Total Due All Years Field for Ad hoc Reporting
PATH: Ad Hoc Reporting > Filter Designer > Student > Fees

A new Ad hoc field called "totalDueAllYears" was added to the Student data type in the Filter Designer. This new
field reports the current fee balance for all of a student's unpaid fees regardless of the year in which they were
first assigned. .

Product Information: Fees Filter Fields for Ad hoc Reporting

Update to Allow Modifying Fund Accounts
PATH: System Administration > Payments > Payment Setup > Fund Accounts

Before this release, districts could only change the Fee Types and School Store Products Types associated with
a Fund Account. Now, districts can make any of the following modifications to an existing Fund Account
including the Default Fund Account:

Add or remove the Food Service option.
Change the Fund ID name.
Change the Bank Account ID.

When you change a Fund ID name and/or Bank Account ID, Campus creates an inactive copy of the original
Fund Account and names it by appending "Archived" to the original name; e.g,"FundName_Archived."
Campus reporting uses "FundName_Archived" for past transactions and uses the new Fund ID name for
new transactions. My Vanco reporting will use the original Fund ID name and/or original bank account for
past transactions and will use the new Fund ID name and/or new bank account for new transactions.

As part of these changes, the "Active" and "Inactive" columns were removed from the summary view of the
Fund Accounts. Instead, there is a new section in the table called "Inactive Fund Accounts." Users can
expand this section of the table to see all inactive Fund Accounts.

Product Information: Fund Accounts (Payments Setup)

Campus.2040
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Custom Tool Placement Editor Now Available
PATH: System Administration > Custom > Custom Tool Placement Editor 

The Custom Tool Placement Editor is now available. This tool allows users to customize where in the new
Campus navigation UI their custom tools will live. Users can either place their custom tools within existing menu
items and categories or customize and create their own menu items and categories.

Districts and Channel Partners: Please use this tool to ensure your custom tools are organized and located in
their proper places.

Product Information: Custom Tool Placement Editor

Search Framework Status Tool Now Available
PATH: System Administration > Search Framework Status  

A new Search Framework Status tool is now available for SIS and Limited Edition product security role users.
This tool is primarily intended for Infinite Campus support personnel. The status page provides a simplified way
to quickly and easily identify the health and status of the search framework within Infinite Campus. The status
page details are only displayed on quartz enabled Campus app servers.

The framework status is color-coded with a message describing the current health of your system. Green means
everything is working properly, blue is a warning that some issues have occurred but the system is not down,
yellow and red mean an error has occurred and the search framework is not functioning properly.

For yellow and red statuses, please reach out to Infinite Campus for further support.

Product Information: Search Framework Status

Completely Redesigned Survey Designer Tool Now Available
PATH: Surveys > Survey Designer

The Survey Designer tool has been completely redesigned to enhance usability and functionality throughout.
Users are now walked through the process using an intuitive wizard with the ability to customize logic for each
question and create questions using a powerful toolset.

Product Information: Survey Designer

Blended Learning - Instruction Changes & Campus Student and
Parent
PATH: Campus Instruction > Roster Student Groups, Message Center; System Administration > Attendance >
Virtual Attendance Preferences; Campus Student; Campus Parent

The following updates have been made in Instruction to support Blended Learning:

The Roster, Student Groups, and the Message Center have been updated to display a student's blended
learning group that is active during the term selected in the Campus toolbar.
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Seating Charts has been updated to display the blended learning groups that are active for the section.
Printed Planner and Roster reports have been updated to show blended learning groups.

Additionally, a new Virtual Attendance Preference has been added called 'Indicate that attendance was taken
when a teachers saves participation for a previous day.' If this preference is marked, when a teacher saves
participation for a section for a previous day, the Classroom Monitor and Attendance screens will indicate that
attendance has been taken for that day.

The following updates have been made to Campus Student and Campus Parent:

A new preference has been added to the Display Options to display the student's Blended Learning Group
on the Today screen.
(Kentucky only) A log of student responses to check-ins now displays, as is shown in other states.
Check-in data for all states now displays in a side panel, instead of mixing the data in with attendance.

Product Information: Campus Parent, Campus Student

Virtual Attendance Preferences - Warning When Modifying
Preferences
PATH: System Administration > Attendance > Virtual Attendance Preferences 

A warning has been added when the Virtual Attendance Posting Preference is enabled and students may not
have Student Participation records for dates after the Attendance Posting Start Date because Participation-
based Entry was not enabled.

When Virtual Attendance Posting is enabled and saved in a calendar where Participation-based entry of Virtual
Attendance was not enabled in the range between the Attendance Posting Start date and the Posting Job Start
date, a warning displays that indicates the following:

The Attendance Posting Code will be applied to EVERY period from the Attendance Posting Start Date
forward for virtual students.
Teacher-entered attendance will be removed.

Product Information: Virtual Attendance Preferences

Student Profile - Blended Learning Virtual Indicator
PATH: Student Information > General > Profile

A virtual indicator now displays on the Attendance Card when viewing the details of an attendance record when
the student is attending school virtually on any given day.

Product Information: Profile

School Store and Category Screen Restructure
PATH: School Store > Administration > Categories
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The following changes were made for the School Store.

The School Store tools were moved out of System Administration to the top level in the Index.
A new tool was added for managing School Store and Activity Registration Categories. Previously,
Categories for these modules were managed in separate tools. The new Categories tool can be found in
School Store > Administration > Categories. The School Store and Activity Registration can now use the
same Categories.
A new menu item called Product Inventory was added. The Product Inventory menu includes a new tool
called "General Product" where Products are managed. Previously, Products were managed by clicking
the Products button on a Category.

Product Information: School Store; Categories (School Store)

Partial Refunds for School Store Products
PATH: System Administration > Payments > Payments Reporter; School Store > Product Inventory > General
Product

Districts can now use the Payments Reporter to issue partial refunds for items purchased in the School Store.
As part of this change, a new checkbox called "Partial Refunds" was added to the Product setup. When this
checkbox is marked, partial refunds are allowed for that product. If the item is an inventory tracked item, a new
checkbox called "Return to Inventory" now displays when completing a full or partial refund. When this checkbox
is marked, Campus will return the item to the product inventory.

Product Information: Payments Reporter, School Store

Update for Including Multiple Schools in One Orders Report
PATH: School Store > Reports > Orders 

The Orders report can now be produced for multiple schools at one time. New options on the report editor allow
you specify which schools to include in the report. There are also formatting options that allow you to group the
report by School, School/Room Number, School/Item, or by Customer.

Product Information: Orders Report

New Option to Delete Unused Categories and Products
PATH: School Store

Users can now delete Categories if there are not any Products assigned and delete Products if there are no
sales attached. As part of this change, a new toggle called "Show Inactive" was added to the Categories tool and
the General Product tool. When the Show Inactive toggle is set to ON, Campus will display inactive Categories
or Products. Otherwise, when the toggle is set to OFF, only active Categories and Products display.

Product Information: School Store

Ability to View School Store Purchases in Census
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PATH: Census > People > Payments

The Payments tool in Census now provides detailed information about online payments, Food Service deposits,
School Store purchases, and office payments made for an individual person.

Product Information: Payments (People)

Blended Learning Updates
PATH: Student Information > General > Attendance; Scheduling > Blended Learning

New features have been added to the Blended Learning tools:

Scheduling Blended Learning Tools

Entering any part of a calendar name now returns matching options for all of the calendar selection fields.

Student Attendance

The total number of students currently assigned to a group is now listed in parentheses when updating a
group assignment.
An End Group Assignment option has been added. Enter an Effective Date to indicate the LAST DAY the
student is assigned to the current group. Future dates and the current date can be entered, but past dates
cannot be entered.
When a student is not currently assigned to a learning group, but is assigned to a group in the future, the
start date of that group displays.

The following modifications have been made to Blended Learning Tools:

When Creating New Blended Learning Groups or Adjusting Blended Learning Groups, the validation
messages that display are now consistent between the two processes.
The Adjust Blended Learning Groups interface has been updated slightly. Fields have been relocated for
ease of use.
Editing a group (modifying the group color and name) can no longer be done when using the Adjust
Learning Groups tool. This option can only be done when using the New Blended Learning Groups tool.
Performance for creating Blended Learning tools has been optimized.

Product Information: Student Attendance; New Blended Learning Groups; Adjust Blended Learning Groups

School Choice Reports Available in DOCX
PATH: System Administration > School Choice > Reports > Application Status, Application Conflict; System
Administration > School Choice > Post Applications, Process Applications 

The following School Choice Reports can now be generated in DOCX format:

Application Conflict
Application Status
Post Applications
Process Applications
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Product Information: Post Applications Wizard; Process Applications; Application Conflict; Application Status

School Choice Reports Available in DOCX
PATH: Activity Registration > Activity Monitor; School Store > Administration > Categories  

The following changes were made for Activity Registration.

A new tool was added for managing School Store and Activity Registration Categories. Previously,
Categories for these modules were managed in separate tools. The new Categories tool can be found in
School Store > Administration > Categories. As part of this change, School Store Products and Activities
can be assigned to the same Category.
A new checkbox called "Restrict to Associated School Enrollments" was added to "Step 4 - Link to Portal"
in the Activity Builder. When this checkbox is marked, the Recipient dropdown list in the School Store will
only display students who have an enrollment in the active school year for the school associated to the
activity. This includes primary, secondary, and end dated enrollments.
A new checkbox called "Partial Refunds" was added to "Step 4 - Link to Portal" in the Activity Builder.
When this checkbox is marked, partial refunds can be issued in the Payments Reporter for the activity.
If the activity has the "Track Limits" option turned on, a new checkbox called "Return to Inventory" now
displays when completing a full or partial refund. When this checkbox is marked, Campus will return the
activity to the inventory you have available.
The Activity Name can now be changed until registration closes. Please note that if you change the Activity
Name, any completed purchases/registrations that exist when you change the name will still use the
original name (name at the time the purchase was made) in School Store reports.
For districts using the new looks and feel of Campus, a new menu item called Product Inventory was
added in the School Store. The Product Inventory menu includes the Activity Monitor for Activity
Registration. The Activity Monitor can also be accessed in Student Information > Activity Registration >
Activity monitor. For districts still using classic Campus, the Activity Registration tool location has not
changed.
Miscellaneous changes were made for improved performance and for improving the user's experience.

Product Information: Activity Builder; Activity Monitor; Categories (School Store)

Removal of Classic Transcript
PATH: Student Information > General > Transcript

In a future release, the classic Transcript tool, available in Student Information > General > Transcripts, will be
removed from the product. A banner has been added to this tool in both the classic navigation and in the new
navigation to inform users of this change.

The enhanced Transcript, available in Student Information > Counseling > General > Transcript, was released in
the Campus.1745 Release Pack (November 2017). This Transcript tool will be modified to include new features
in future releases.

Product Information: Transcripts (Student); Transcript (Counseling)

Grading Window - Notifications Warning

Copyright © 2021 Infinite Campus. All rights reserved.



PATH: Grading & Standards > Grading Window > Notifications > Send Warning 

A Grading Window Notifications Warning can now be sent to alert teachers and/or supervisors that the Grading
Window is closing soon and they have not yet posted grades for their course sections.

The Notifications feature released in Campus.2036 allows notices to be sent AFTER a Grading Window has
closed. This Warning feature can be used to send notices BEFORE a Grading Windows closes.

Product Information: Grading Window Notifications

Household and Course/Section Search Panels Added to New Look of
Infinite Campus
PATH: N/A

New Household and Course/Section context search panels have been added to the New Look and Feel of
Infinite Campus.

Now, users can access an intuitive search to find and select a household with the ability to navigate to
Household, Person, and Address tools within results.

A course/section search was added, providing a simple way to search for and select sections and courses within
a single search display.

Product Information: Try the New Look of Campus

LTI Configuration - Multiple Connections
PATH: System Administration > Learning Interoperability/Digital Learning Applications > select an LTI partner

The Learning Interoperability/Digital Learning Applications tool has been updated to allow users to set up
multiple connections for a single application, so that different schools or groups of schools within the district can
have separate connections. Each school can only be selected for one connection per provider.

Product Information: LTI Configuration

LTI Configuration - Launch Types
PATH: System Administration > Learning Interoperability/Digital Learning Applications > select an LTI partner

Digital Learning partners configured for Learning Tool Interoperability (LTI) have been updated to include
lozenges that indicate how resources from the partner can be launched. These options include:

Learning Tool - displays in Learning Tools in Instruction.
Assignment Resource - resources can be aligned to specific assignments.

Product Information: LTI Configuration
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Campus.2036
Blended Learning - Archive Ability, Calendar Selection, Other
Updates
PATH: Scheduling > Blended Learning 

Blended Learning Groups can now be archived. This can be only be done for groups that have an end date in
the past; active groups cannot be archived. An _Archived_ field has been added to the Filter Designer for
Student Data Types.

Other Updates to Blended Learning:

When the Campus toolbar has All Years selection, a delay in the selection of a group and a selection of a
calendar no longer occurs.
The Group Start Date now displays on the Preview page when adjusting groups.
The error message for a missing value in the Number of Days in Rotation in New Learning Groups is the
same message that displays in Adjust Learning Groups.
Multiple calendars can now be selected, instead of just one calendar, when adding students to groups
automatically, adjusting a student's group assignment and adjusting a group day assignment. Instead of All
Calendars, a Select All button is available. This multi-select option displays as open, allowing users to
choose a few calendars at one time without having to open the field after each selection.
A message now displays when the Automatic Group Assignment process is running indicating that
changes cannot be made until the process is complete.
The suffix field (Jr., III, etc. ) has been added to the Adjust Group Assignment student selection.
The Group Name field is limited to 100 characters.
When adjusting student groups, the start date for students must be on or after the start date of the group.

Product Information: Blended Learning

Blended Learning - Instruction Updates
PATH: Various tools in Instruction  

Class Serve and the Planner have been updated so that when viewing a roster of students, those whose group
is Virtual on the selected day display with an indicator. The following tools and reports have been updated to
include Blended Learning Group information: Attendance list, Roster, Roster Report, Student details, Seating
Chart, Student Groups, Message Center, and Planner.

Additionally, teachers can now enter dates in the future in the Attendance tab to see which students will be
physical or virtual on a given day.

Campus Student and Campus Parent to show how students responded to Attendance check-ins on the
Calendar > Attendance view.

Product Information: Class Serve, Planner, Instruction Daily Tasks

Blended Learning - Copy Virtual Attendance Preferences
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PATH: System Administration > Attendance > Virtual Attendance Preferences Copier Wizard 

The Virtual Attendance Preferences can now be copied to other calendars using the Virtual Attendance
Preferences Copier Wizard.

All selected virtual attendance preferences in the Source Calendar are copied to the Destination Calendar. If the
Destination Calendar already has preferences selected, they are overwritten with this process.

Product Information: Virtual Attendance Preferences; Copy Wizard

Blended Learning - Future Group Start Date
PATH: Student Information > General > Attendance

For students who are not currently assigned to a Blended Learning Group but are assigned to a group with a
futures start date, that start date displays when hovering over the Blended Learning Group icon.

Product Information: Student Attendance

Blended Learning - Automatic Group and Membership Assignment
PATH: Scheduling > Blended Learning 

The original COVID-19 Attendance Process available for recording virtual attendance in the 2019-20 school year
has been replaced with Virtual Attendance Preferences, along with several other tools for Blended Learning.

If your district was using the original COVID-19 Attendance Process for recording attendance for students in the
2020-21 school year BUT Blended Learning Groups have NOT been created, one Blended Learning Group will
be created automatically and all students enrolled in a calendar with Enable Covid-19 assignment insert marked
will be assigned to that new group.

In addition, that automatic group, COVID-19 Attendance, is also associated with every attendance day in the
affected calendar, accounting for all dates prior to taking this update. Students in calendars that do not have the
COVID-19 Attendance assignments enabled will not be placed in the group.

Product Information: Blended Learning Groups

Blended Learning - Students without Households
PATH: Scheduling > Blended Learning 

Students who have no assigned household or are in a primary household without an address are now included in
the automatic group creation process.

Product Information: Blended Learning Groups

Blended Learning - Future Group Display
PATH: Scheduling > Blended Learning 
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For students who do not have a current Blended Learning Group assignment but are assigned to a group with a
future start date, the Blended Learning Group icon now displays in the student header. Hovering over the icon
displays the start date for that group.

Note that future group assignments do not display on Student Attendance.

This applies to the classic navigation of Campus only.

Product Information: N/A

Blended Learning - Ad hoc Reporting Participation Detail View
PATH: Scheduling > Blended Learning; Ad hoc Reporting > Filter Designer > Query Wizard

A Blended Learning Participation Detail view has been added to the Student > Attendance folder in the Filter
Designer. This option includes fields to create reports using the participation records of students, whether added
by a student check in, a parent check in or a teacher entry of participation.

Product Information: New Blended Learning Groups

Ad hoc Reporting - Blended Learning Term Summary View
PATH: Ad hoc Reporting > Filter Designer > Query Wizard

New Blended Learning views have been added to the Query Wizard for the Student Data Type and the
Course/Section Data Type.

For the Student Data Type, the *Blended Learning Term Summary* is available in the Student > Attendance
folder. Use this view to find the total count of days a student is attending classes virtually and physically for a
term.

For the Course/Section Data Type, the *Blended Learning Summary view* and *Blended Learning Summary
(Overall)* are available in the Course > Section Information folder. Use these views to find the total count of
students associated with particular Blended Learning groups.

Product Information: Query Wizard

School Store - New Pick List Columns
PATH: System Administration > School Store > Reports > Pick List

The following two new columns were added to the Pick List: Student Number and Payment Reference Number.
The Payment Reference Number can be used for cross-checking in the Payments Reporter. These fields are
also available in Ad Hoc.

Product Information: Pick List

School Store - Orders Report Update for Large Labels
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PATH: System Administration > School Store > Reports > Orders  

The Orders report now includes the option to generate large labels in PDF format that can be used for labeling
boxed/bagged food. To create the Large Label PDF, users must select "Labels - Large" in the Report Type
dropdown list on the Orders Report editor. This report is designed to be printed on Avery 8395 Adhesive Name
Badges. Eight labels print on each page. PIN and barcode information is included on the label if Point of Sale is
enabled.

Product Information: Orders Report

Grading Window Notifications
PATH: Grading and Standards > Grading Window > Notifications

The Grading Window now includes the ability to send notifications to teachers alerting them that they have not
posted scores for the Grading Window.

Notifications are customizable and can be sent to teachers (staff marked as Primary Teachers and Teachers on
Staff History), to teacher's supervisors (marked on the District Assignment record), or both, and can include a
report that lists missing grades (the same format that's included in the Grades Report).

Product Information: Grading Window

Activity Registration Updates
PATH: Activity Registration 

The following updates were made to Activity Registration.

Added the ability to manually add students to an Activity Roster if they are enrolled in the school
associated with the activity.
Added the ability to remove students that were manually added from an Activity Roster.
Added the option to remove an activity from the Activity Monitor by deleting or cancelling the activity.
Product Description and Special Instructions fields can now be updated until registration is closed.
The Activity Image on "Step 4 - Link to Portal" on the Activity Builder can be updated through the
Registration status.
The Activity Primary and Secondary Owners can now be updated until the activity is in a Closed status.
Miscellaneous cosmetic and performance improvements were made for an improved user experience.

Product Information: Activity Registration

Early Warning Updated to Include K-5 GRAD and Category Scores
PATH: Student Information > Early Warning

Early Warning functionality has been updated to support the calculation and display of GRAD and Category
Scores for Kindergarten through 12th grade students.

Product Information: Early Warning
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Special Ed Goal Monitoring Tool Added
PATH: Student Information > Special Ed > General > Goal Monitoring 

A new tool, Goal Monitoring, has been added to the Special Ed module. This tool is designed to document the
student's progress toward their special education goals.

Product Information: Special Ed Goal Monitoring

Daily Health Log Stored Procedure
PATH: Student Information > Health > General > Daily Health Log

A stored procedure has been created to automatically set the status on the Daily Health Log tool and add a
program flag for a student based on the student’s symptoms.
The stored procedure has the following parameters:

1. Status HS1: Sick - No Learning Advised

Student has a fever of 100.4 or higher or the student has more than one symptom.

2. Status HS2: Quarantine - Safe for Online Learning

Student has 14 calendar days or less since exposure or student has three days or less of no symptoms
since HS1 status or student has ten days or less since positive test.

3. Status HS3: Approved for Classroom

Student has four days or more of no fever since HS1 status and ten or more days since last HS1 status
with multiple symptoms or two negative tests at least a day apart.

In order for Status to automatically update, each respective Code must be active in the Attribute/Dictionary (HS1,
HS2, HS3). Also, in order for a flag to display in the person header, a flag must be set up in Program Admin with
the respective Code (HS1, HS2, HS3).

Product Information: Daily Health Log

Food Service Account PIN Barcode in Campus Parent
PATH: System Administration > Portal > Preferences > Display Options

Student's Food Service PINs are now available as a barcode in Campus Parent on the Today screen. Parents
can use their student(s) barcode to make Food Service purchases by using the student selector then going to
the Today page for each student. Only one student's barcode can display at one time. As part of this new
feature, a new checkbox called "Display Food Service PIN Barcode on Today screen" was added to the Display
Options tool in the Portal Preferences. Campus only displays a barcode if the student is enrolled in a school that
has the preference turned on. The new checkbox is not automatically selected. To make the barcode display in
Campus Parent, mark the new checkbox. Turning this preference on also makes student's barcodes available in
Campus Student.
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Product Information: Display Options

Food Service Account PIN Barcode in Student App
PATH: System Administration > Portal > Preferences > Display Options

Student's Food Service PINs are now available as a barcode in Campus Student. Students can use the barcode
to make Food Service purchases. As part of this new feature, a new checkbox called "Display Food Service PIN
Barcode on Today screen" was added to the Display Options tool in the Portal Preferences. The new checkbox
is not automatically selected. To make the barcode display in Campus Student, mark the new checkbox. Turning
this preference on also makes student's barcodes available in Campus Parent.

Product Information: Display Options

New Custom Lunch Count Checkboxes
PATH: FRAM > Reports > Lunch Counts; Attendance > Reports > Lunch Counts

The following new Attributes were added to the System Administration > Custom > Attribute/Dictionary > Section
so that schools can add their own checkboxes to the Lunch Count area on a Section: LunchCount, MilkCount,
AdultCount, Custom Count 1, Custom Count 2, and Custom Count 3. These attributes can be renamed to meet
your district's needs and are included in the Lunch Counts Report.

As part of this change, the Lunch Counts report can now be found in Attendance > Reports in the Campus Index
as well as in FRAM > Reports.

Product Information: Lunch Counts Report

Campus.2032
Virtual Attendance in Instruction and Campus Student/Parent
PATH: Campus Instruction > Attendance, Seating Chart, Control Center; Campus Student; Campus Parent 

Attendance tools in Instruction have been updated for Virtual Attendance. Based on the selections made by the
school in the Virtual Attendance Preferences and Blended Learning setup, an additional section may display in
the Attendance tool for recording attendance for students attending virtually. Depending on setup, teachers may
see the following options:

May or may not be able to mark attendance for students attending virtually.
An indicator of whether the student has responded to the attendance Check-In may display. Parents may
also be able to respond to the check-in for the student.
A checkbox indicating if the student participated that day. Teachers may be able to mark students as
participated, and may be able to modify the student's response.
A date picker may display at the top of the Attendance screen to all teachers to record participation for
previous days.
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Note: Depending on school setup, this participation checkbox may be used to determine student
attendance. Follow school guidelines for how these fields are used.

The Control Center was also updated to allow recording of virtual attendance. In the Seating Chart, a Virtual tag
displays for students attending virtually but virtual attendance cannot be recorded from this tool.

In Campus Student and Campus Parent, a Virtual tag has been added to the Today screen and Calendar >
Schedule to indicate days when the student is Virtual. Check-Ins also display on the Today screen. Check-ins
may be posted once per day or per section (with the option to limit by period times or set start and end times). If
enabled, parents can also respond to a Check-in.

Product Information: Attendance, Control Center, Campus Student, Campus Parent

Blended Learning - COVID-19 Attendance Tools
PATH: System Administration > Calendar > Calendar > Calendar Info; System Administration > Attendance >
Attendance Codes

Attendance tools that were updated to allow for the recording of attendance through assignments for schools
transitioning to distance learning for COVID-19 restrictions have been removed or modified for additional
features that are part of the Blended Learning workflow and toolset.

COVID-19 Assignment-Based Attendance attributes on the Calendar Details/Calendar Information editors have
been removed. These attributes are now part of the Virtual Attendance Preferences editor. Details on converted
data are included in the Virtual Attendance Preferences article.

COVID-19 Assignments have been converted to Student Participation records if the Assignment has a score of 1
or greater or has the Turned In flag set. The COVID-19 score group, grading task, and category used for these
assignments have been deactivated. The scheduled tasks for inserting COVID-19 assignments and posting
attendance have been removed.

Product Information: Attendance Codes; Calendar Details; Virtual Attendance Preferences

Student Schedule - Blended Learning Display
PATH: Student Information > General > Schedule 

The Student Schedule has been updated to include an indication of Virtual when a student has been assigned to
a Virtual Learning Group that is attending virtually on the day being viewed on the schedule. This displays on the
Day, Week and Agenda views.

Product Information: Student Schedule
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Daily Attendance Updates for Blended Learning
PATH: Attendance > Daily Attendance

The Daily Attendance tool now includes the Blended Learning Group icon next to a student's name when the
student's group is virtual on the selected date.

Product Information: Daily Attendance

Section Roster Report - Blended Learning Options
PATH: Scheduling > Reports > Section Rosters; Scheduling > Courses > Course > Section > Roster 

The Section Roster Report has been modified to include options to display Blended Learning information.

A Show Blended Learning Group Summary option has been added to the Display Options. When
marked, Blended Learning Group roster summary counts display in the summary information just below the
header of the report.
A Blended Learning Group option has been added to the Student Options. When marked, the name of
the Blended Learning Group displays for each student.

This new functionality is not yet available on the Section Roster report when loaded from Campus Instruction.

Product Information: Section Roster Report

Blended Learning Groups
PATH: Scheduling > Blended Learning Groups

The following enhancements have been made to Blended Learning Groups:

Group names can now be modified after their original creation.
Users can now choose between two different icons to assign to groups. This allows for distinguishing
between groups that may be always virtual or always on-site.
Users can now assign different colors to groups.

A new option for Adjust Group Day Assignments has been added. This allows users to quickly modify which
days a group is scheduled to be virtual or on-site and to change the rotation of those groups accordingly, if
needed.

When assigning students to groups automatically, a status bar displays, showing the percentage of completion
for the selected calendar(s).

Product Information: New Blended Learning Groups; Adjust Blended Learning Groups
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Blended Learning - Campus Fields for Letters/Messages
PATH: Messenger > Message Builder; Ad hoc Reporting > Letter Designer 

Blended Learning fields have been added to the Campus Fields available when creating messages and building
letters. These fields are now available for inclusion in all tools that allow messages (e.g., Message Builder, Class
Messenger, Schedule Messenger, etc.) and letters (e.g., Ad Hoc Letter Designer, Attendance Letter Wizard,
etc.) to be created.

Product Information: Message Builder; Letter Designer

Blended Learning Group Display on Schedule Report Preferences
PATH: System Administration > Preferences > Reports > Schedule  

A new Display Option for Blended Learning Groups has been added to the Schedule Report Preferences. When
marked and a student is assigned to a Blended Learning Group, the group name prints at the end of the report
with the other Display Options.

As long as the Blended Learning Display Option is marked, the Group Name is included on the report,
regardless of whether it is being generated from the Student Schedule tab, Schedule Batch tool or the Campus
Student/Parent Application.

Product Information: Schedule Report Preferences

Student Attendance Updates for Blended Learning
PATH: Student Information > General > Attendance  

The Student Attendance tool now includes the Blended Learning Group icon next to the date when the group
meets virtually on that day.

Product Information: Student Attendance

Classroom Monitor Updates for Blended Learning
PATH: Attendance > Classroom Monitor

The Section Attendance roster accessed through the Classroom Monitor now includes an indication of which
students are Virtual students for a given day.

Students who are on-site (not virtual) for the day display first. Virtual students display with a Participated
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indicator next to their name if their participation has been confirmed by the teacher or student check in.

Product Information: Classroom Monitor

Course Section Attendance Display for Blended Learning
PATH: Scheduling > Courses > Course > Section > Attendance  

The Section Attendance editor now includes an indication of which students are Virtual students for a given day.

Students who are on-site (not virtual) for the day display first. Virtual students display with a Participated
indicator next to their name if their participation is confirmed by the teacher or student check in.

Product Information: Section Attendance

Ad hoc Reporting - Blended Learning Fields
PATH: Ad hoc Reporting > Filter Designer > Query Wizard; Ad hoc Reporting > Data Analysis 

New Query Wizard fields for the Student Data Type have been added to see if a student has an active
assignment in a Blended Learning Group that is assigned to the current day and to the next day.

These fields, called virtualToday and virtualTomorrow are available in the Learner > Blended Learning > Active
Group Assignment folder. These fields use the =True/=False operators and report as either 1 (true - the student
has an active assignment in a group that is virtual today or tomorrow) or 2 (false - the student has an active
assignment in a group that is NOT active today or tomorrow).

Product Information: Query Wizard, Data Analysis

Section Roster - Blended Learning Indicator
PATH: Scheduling > Courses > Course > Section > Roster

An indication of a student being in a Blended Learning Group and a total number of students who are in Blended
Learning Groups has been added to the Section Roster tool.

Product Information: Roster (Section)

Blended Learning - Job for Posting Attendance Records for Virtual
Students
PATH: Student Information > General > Attendance; System Administration > Attendance > Attendance Codes 
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An attendance posting job for students who are attending classes virtually on a specific date has been created.
This process assigns a calendar-specific attendance code when the student does not have a check in or a
participation confirmation from the teacher for a particular course section. If the calendar was using the COVID-
19 attendance solution previously, the same attendance code can be used for this posting job.

This job is only enabled when the Enable Virtual Attendance Posting option is selected on the Virtual Attendance
Preferences and the following fields are populated for the selected calendar:

Posting Job Start Date
Frequency
Time
Attendance Posting Start Date
Attendance Posting Code

Every time the job runs, students in a Blended Learning Group that is virtual on a day between the current date
and the Attendance Posting Start Date who do not have participation confirmed by the teacher or by student
check in will have an attendance record created with the selected code and a comment, "Virtual participation not
verified". Existing records for the date and period will be updated if student participation is confirmed.

As part of this process, the Allow assignment-based attendance modification checkbox on the Attendance
Codes editor has been renamed to Use code in virtual attendance posting. Functionality of the checkbox has
not changed.

Product Information: Student Attendance; Attendance Codes

Virtual Attendance Preferences
PATH: System Administration > Attendance > Virtual Attendance Preferences

New Virtual Attendance Preferences are now available for tracking student participation in a virtual classroom
setting.

For virtual students in a course section, users can:

Use classroom attendance
Turn off classroom attendance, so all attendance is processed through administrative tools.
Choose to allow students and/or parents to check in for the day or for each course section.
Choose a start and end time for daily or course section check in or limit check in between the period start
and end times.
Allow the teacher to mark a student as participated for a number of previous days.
Allow the teacher to override a student's participation check in

Options for posting virtual attendance are also available. These options determine when the attendance entries
are posted and what attendance code is used.

Product Information: Virtual Attendance Preferences
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New Pre-Order Food Service Toggle
PATH: System Administration > School Store > Settings

To help districts prepare for contactless food service, a new toggle called "Enable School Store for $0 Orders
(i.e. Pre-Order Food Service)" was added to the School Store > Settings tool. This toggle is meant for districts
who do NOT use Online Payments but want to give students the option to pre-order meals using the School
Store. When this toggle is turned on, districts can set up the School Store with Food Service meals that can be
purchased for $0.

Product Information: Contactless Food Service Whiteboard

Display Student Number Barcode in Student App for POS Customers
PATH: System Administration > Portal > Preferences > Display Options 

A new contactless payment feature is now available for Point of Sale customers who set their student's PINs to
be the same as their Student Number. If student PINs are the same as their student number, a terminal
equipped with a 2D scanner can read the student's barcode from their mobile device and process the
transaction. This feature eliminates the need to distribute a paper barcode and allows contactless payment.

To use this feature, mark the "Display Barcode of Student Number on Campus Student" checkbox in the Display
Options tool.

Product Information: Display Options

New Select All Toggle on Pick List
PATH: System Administration > School Store > Reports > Pick List 

A new toggle was added to the Picked Up column on the Pick List report. When this toggle is switched on, a
confirmation message displays and you can mark all items as picked up. Turning the toggle off clears the Picked
Up checkbox.

Product Information: Pick List

School Store in Ad Hoc Reporting
PATH: Ad Hoc Reporting

The following School Store fields are now available in Ad Hoc reporting. These fields are available when
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building a Student selection filter or a Census/Staff selection filter then picking School Store > Pick List.

itemName
customerComments
purchaseDate
schoolID
recipient
customer
itemSKU
transactionType
pickedUp
recipientPersonID
schoolName
categories

Product Information: School Store Fields for Ad Hoc Reporting

New Receipt Text Option for School Store & Activity Registration
PATH: System Administration > School Store > Category > Products; Activity Registration > Activity Monitor >
Activity Builder

Districts can now include more information on receipts. A new text box called "Receipt Text" was added to the
Product setup screen in the School Store and the Link to Portal step of the Activity Builder. Use this new field to
enter any comments that you want to display on the customer's receipt. Now, when a user prints a receipt from
Campus Parent or Campus Student, or views their Payment History, the Receipt Text displays on their receipt
below the item they purchased. Receipt Comments that you set up in System Administration > Payments >
Payment Setup > Settings for the district still display at the top of the receipt.

Product Information: School Store; Activity Builder

Online Payments & School Store Cosmetic Updates
PATH: System Administration > Payments; System Administration > School Store 

Miscellaneous cosmetic updates were made to improve the appearance and usability of these tools.

Product Information: N/A

Online Order Report
PATH: System Administration > School Store > Reports > Orders

The new Online Order Report is available in CSV format and includes people who have pre-ordered meals
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through the School Store. The report is created for one school at a time. The School you select is the school
from which the pre-order was placed and not necessarily the school where a student is enrolled. This report can
be used to facilitate contactless food service. For example, schools could use the report to create a list for
distributing meals to classrooms or for creating labels for boxed/bagged food.

Product Information: Orders

Daily Health Log on Parent and Student Portals
PATH: Parent Portal

The Daily Health Log tool has been made available in the Campus Parent Portal and Campus Student Portal to
allow parents and students to view daily health screening information.

Product Information: Campus Parent Portal

New Daily Health Log
PATH: Student Information > Health > Daily Health Log

The Daily Health Log has been made available to allow schools to track symptoms of students on a daily basis
which can then be used to determine if students can attend classes in person, online, or have no learning due to
illness.

Product Information: Daily Health Log

New Activity Staff District Assignment and Misc Updates
PATH: Census > People > District Assignments; Activity Registration > Activity Monitor > Activity Builder

A new District Assignment checkbox called "Activity Staff" is now available. When this checkbox is marked, the
staff member may be assigned as the primary or secondary owner responsible for an activity in the Activity
Registration tool. This new option was also added as a "Role" for districts that use the Human Resources
module.

A new option called "Receipt Comments" was added to Step 4 - Link to Portal in the Activity Builder tool. This
field allows you to enter comments or special instructions that you want on the customer's receipt.

The "Post to Course Section" toggle is now available on the Roster tool. When the toggle is turned on, you can
associate the activity with a School, Calendar, Course and Section then you can push the applicable students to
the roster in Campus once registration is closed.

Cosmetic changes were also made to improve the general user experience.
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Product Information: District Assignments; Activity Builder; Activity Monitor and Activity Roster

Grading Window - Editing, Scheduling and Management
PATH: Grading and Standards > Grading Window 

Based on user feedback for the updated Grading Window, additional modifications have been made, as follows:

Users now have the ability to easily modify existing Grading Windows.
Grading Windows can now be scheduled for more than one Grading Window per grading task and term
(e.g., a grading window can be created for teachers to post a progress grade every other week).
A list of all Grading Windows for the district displays. This can assist administrators with verifying Grading
Windows have been created and see at a glance if something needs changing (dates, grade levels, etc.).
Grading Windows for a specific grade level can be created in the main Grading Window workflow AND in
the Grading Window Exceptions workflow.
The layout has also been modified to show the scheduling workflow next to a list of all Grading Windows to
preview existing records when making modifications.

Product Information: Grading Window

Content Security Policy Detail Updated for Clarity
PATH: System Administration > User Security > Content Security Policy

The UI of the Details section in the Content Security Policy tool has been updated to better explain information
and improve the overall clarity of the details contained within.

Product Information: Content Security Policy

Data Validation Tools for District Editions
PATH: System Administration > Data Integrity Tools > Data Validation 

Full Access to the new Data Validation tools has been made available to District Editions that have licensed the
Data Analytics Suite. Restricted Access has also been made available to all other non-state-linked District
Editions.

Product Information: Validation Rules, Validation Groups, Data Validation Report, Stored Procedures Setup

Professional Development - End of Life
PATH: Professional Development; Campus Instruction > Professional Development
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The Professional Development tools will be removed at the end of the year. A message warning of this removal
has been added to each of the tools.

Users looking to learn more about Campus should refer to our Study Guides:
https://kb.infinitecampus.com/help/study-guides.

Product Information: Professional Development

Campus.2028
New Activity Registration Module
PATH: Activity Registration

A new module called Activity Registration is now available for districts that also use the School Store. The
Activity Registration module provides districts with a tool for managing activities that require a registration
process including a registration packet, payment, and a roster.

Registration and payments are completed in the School Store. Activities display in the School Store based on
registration dates that the district controls. An Activity Roster in Campus displays all registered students and
allows the district to identify which students have paid and completed their required forms.

To use the Activity Registration module, districts must first set up supplemental Activity Registration documents
in the Custom Forms tool and create an Ad Hoc filter for selecting eligible students. For more information, see
the Activity Registration documentation.

Product Information: Activity Registration; Activity Monitor

School Store - Start and End Time for Products
PATH: System Administration > School Store > Products

The Start Date and End Date fields on the Product Availability screen were updated to include the time. Users
can now set a specific day and time for when the product is available in the School Store.

Product Information: School Store

School Store Checkout Validation
PATH: School Store

Miscellaneous updates were made to the School Store to improve some minor functionality. With this update,
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buyers will receive a message if the quantity they want purchase exceeds the number available for an inventory
tracked product. Also, users will now see a message if an item's price changed after they added it to their cart.

Product Information: School Store

Updating Imported Frameworks - Standard Associations
PATH: Grading & Standards > Standards Bank > Import

When a framework is re-updated to capture changes made by the state, any changes to associations between
items are also updated, as of this release.

Product Information: Import Standards

Student Flag Indicator for Blended Learning Group Assignment
PATH: Student Information > General > Flags 

A Blended Learning Group Flag displays in the student header that indicates to which Blended Learning Group
the student is assigned.

This is part of a series of enhancements related to Blended Learning as you prepare your building for students to
return to school in the fall. Look for additional enhancements in the next release.

See the Release Notification for Blended Learning for additional information.

Product Information: Student Flag

Blended Learning Schedules
PATH: Scheduling > Blended Learning

New scheduling tools for Blending Learning classroom and instruction is now available. Schools can create
learning groups, allowing each student to be designated as a virtual learner, a physical (on-site) learner, or a
learner who alternates between virtual instruction and physical instruction.

This is the first in a series of enhancements related to Blended Learning as you prepare your building for
students to return to school in the fall. Look for additional enhancements in the next release.

See the Release Notification for Blended Learning for additional information.

Product Information: Blended Learning
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Student Attendance - Blended Learning Group Display
PATH: Student Information > General > Attendance 

As part of the new Blended Learning tools, the Student Attendance tool now includes indication of the Blended
Learning Group to which the student belongs. Users who are assigned proper tool rights also have the ability to
update the group assignment.

This is part of a series of enhancements related to Blended Learning as you prepare your building for students to
return to school in the fall. Look for additional enhancements in the next release.

See the Release Notification for Blended Learning for additional information.

Product Information: Student Attendance

Calendar Days - Day Rotation Warning Message
PATH: System Administration > Calendar > Calendar > Days

The warning message that displays when using the Day Rotation option has been modified to include Blended
Learning Group Assignments.

This is part of a series of enhancements related to Blended Learning as you prepare your building for students to
return to school in the fall. Look for additional enhancements in the next release.

See the Release Notification for Blended Learning for additional information.

Product Information: Calendar Days

Calendar Days - Blended Learning Group Display on Calendar Days
Report
PATH: System Administration > Calendar > Calendar > Days

The Calendar Days Rotation Report now includes an option to print Blended Learning Group Assignments which
modifies the report to display an additional page for each Blended Learning Group assigned to at least one day
in the selected calendar.

This is part of a series of enhancements related to Blended Learning as you prepare your building for students to
return to school in the fall. Look for additional enhancements in the next release.

See the Release Notification for Blended Learning for additional information.

Product Information: Calendar Days
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Calendar Days - Blended Learning Group Display
PATH: System Administration > Calendar > Calendar > Days

As part of the new Blended Learning tools, the Calendar Days tool now includes indication of the Blended
Learning Group assigned to the selected day. Days can be assigned to a Blended Learning Group en masse
through the Scheduling > Blended Learning tools, or manually added/modified on the Days tool.

Blended Learning Group Assignment is not impacted by the Day Reset function but is removed by the Day
Rotation function if the Day Rotation is used after the Groups have been assigned.

This is part of a series of enhancements related to Blended Learning as you prepare your building for students to
return to school in the fall. Look for additional enhancements in the next release.

See the Release Notification for Blended Learning for additional information.

Product Information: Calendar Days

New Options for Hiding Fees from Campus Parent & Campus Student
PATH: Fees > Fees 

Districts can now control which fees are visible in Campus Parent and Campus Student. When creating a fee,
there are two new checkboxes on the Fee Editor: Display on Parent Portal and Display on Student Portal. These
checkboxes are automatically marked when creating a new fee. As part of this change, existing fees will also
have both checkboxes marked. To hide a fee from Campus Parent or Campus Student, clear the appropriate
checkbox(es).

Product Information: Fees (Fees)

New Create User Group Tool Now Available
PATH: System Administration > User Security > Create User Group 

The new Create User Group tool is now available. This tool replaces the old way of creating user groups within
Campus with a new streamlined process which includes updated UI and improved user experience.

Product Information: Create User Group

New Create User Account Tool Now Available
PATH: System Administration > User Security > Create User Account

The new Create User Account tool is now available. This tool replaces the old way of creating a user account
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within Campus with a new streamlined process which includes an updated UI and improved user experience.

Product Information: Create User Account

Update to Pay Fee Wizard Assignments with Surplus Balances
PATH: System Administration > Preferences > System Preferences > Auto-pay Fees with Surplus Balance

When the Fee Wizard is used to assign new fees or change exempt fees to unexempt, these fees are now
automatically paid from the Surplus Balance when the Auto-pay Fees with Surplus Balance preference is turned
on.

Product Information: Auto-pay Fees with Surplus Balance (District Preference)

Try New Look of Campus Toggle District Preference Added
PATH: System Administration > Preferences > System Preferences > User Access to the New Look of Campus

A system preference has been added, allowing district to control whether the Try New Look of Infinite Campus
toggle appears for all users, only Campus Instruction users, or no users. The Try New Look toggle is now
available within the User Menu (the person icon in the upper right-hand corner of the screen) and will appear
here depending on the preference value set.

By default, this preference is set to ‘All Users’ for Campus Cloud and Cloud Choice customers.

Note for In-District and Self-Hosted Customers: This preference is visible but set to ‘No Users’ as the Try
New Look UI is currently not available for these hosting mode.

Product Information: System Preferences, Try the New Look of Campus

Status Column Added to Payment History
PATH: My Accounts > Payment History 

A new column called "Status" was added to the Payment History screen to help users identify the state of their
payments. The new column displays the following statuses.

Completed - All the items in the transaction are in completed state or resolved state.
Returned - All the items in the transaction are in returned state
Partially Returned - One or more (but not all) items in the transaction are in returned state
Error - All the items in the transaction are in an error state (canceled, exception, or revoked)
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Product Information: Payment History

Custom Forms eSignature Feature Added
PATH: Student Information > Student Information > General > Forms; Student Information > General Student
Administration > Custom Form Setup; Student Information > (Module) > (Module) Documents

Users now have the ability to send a Custom Form to parent/guardian(s) and/or student(s) to the Portal to be
electronically signed.

Product Information: Forms

Team Members Role Field Update
PATH: Student Information > Module > General > Team Members 

Several updates have been made regarding the Team Members Role fields:

The Role dropdown has been removed from the Team Member Enter New Team Member tool for all
modules.
The Role dropdown on the Find and Link New Team Member tool has been renamed to Caseload Role for
the PLP and Special Ed modules (ILPA for Kentucky users).
Roles that are no longer used have been removed as options for the Role dropdown, including View Only,
Read Only, Write, and Advisor. These roles do not have any additional functionality.

Product Information: Counseling Team Members; PLP Team Members; RTI Team Members; Special Ed Team
Members; (KY Only) ILPA Team Members

Data Validation Tools Updates
PATH: System Administration > Data Integrity Tools > Data Validation

The User Interface for the Data Validation tools has been updated to be more user friendly. The tools have also
been updated to allow more control over DIS, and Stored Procedures are now supported.

Full Access to the new Data Validation tools is available to State Editions and Restricted Access has been made
available to state-linked District Editions. Full Access is made available to District Editions that have licensed the
Data Analytics Suite. Restricted

Access will be made available to all other non-state-linked District Editions in the future.

Product Information: Validation Rules, Validation Groups, Data Validation Report, Stored Procedures Setup
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